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Официальное уведомление 

Гарантийные обязательства

Единственные гарантийные обязательства в отношении продуктов и услуг компании НР изложены 
в заявлении о прямых гарантийных обязательствах, которое прилагается к таким продуктам и 
услугам. Никакая часть настоящего документа не должна рассматриваться как дополнительные 
гарантийные обязательства. Компания НР не несет ответственности за технические или 
редакторские ошибки и неточности, содержащиеся в данном документе.

Информация, содержащаяся в настоящем документе, может быть изменена без уведомления.

Пояснения к ограниченным правам

Конфиденциальное компьютерное программное обеспечение. Для владения, использования или 
копирования необходима действующая лицензия компании HP. В соответствии с положениями 
FAR 12.211 и 12.212 коммерческое компьютерное программное обеспечение, документация 
компьютерного программного обеспечения и технические данные коммерческих продуктов 
лицензируются государственным учреждениям США на условиях стандартной коммерческой 
лицензии поставщика.

Веб-сайты сторонних производителей

Компания НР предоставляет ссылки на сайты сторонних производителей, содержащих 
дополнительную информацию.  Содержимое и доступность таких веб-сайтов могут быть изменены 
без уведомления.  Компания НР не делает никаких заявлений и не дает никаких гарантий в 
отношении содержимого или доступности таких сайтов.

Уведомление об авторских правах

© Hewlett-Packard Development Company, L.P., 1993-2009.

Уведомление о товарных знаках

Adobe® является товарным знаком компании Adobe Systems Incorporated.

Microsoft® и Windows® являются зарегистрированными в США товарными знаками корпорации 
Майкрософт.

Oracle® является зарегистрированным товарным знаком корпорации Oracle и/или ее дочерних 
компаний.
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Обновление документации

На титульном листе настоящего документа приведена следующая информация.

• Номер версии программного обеспечения.

• Дата выпуска документа, которая изменяется при каждом обновлении документа.

• Дата релиза программного обеспечения, т. е. дата релиза текущей версии программного 
обеспечения.

Чтобы проверить наличие обновлений или убедиться в том, что вы пользуетесь самой последней 
редакцией документа, перейдите на

http://h20230.www2.hp.com/selfsolve/manuals 

Для доступа к этому сайту необходимо зарегистрироваться в службе HP Passport и выполнить вход. 
Чтобы зарегистрироваться для получения идентификатора пользователя службы HP Passport, 
перейдите по адресу 

http://h20229.www2.hp.com/passport-registration.html 

Также можно перейти по ссылке New users - please register на странице входа в службу HP 
Passport.

Подписка на поддержку соответствующего продукта также дает возможность получения 
обновленных или новых выпусков. Подробные сведения можно получить у торгового 
представителя компании HP.
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Поддержка

Веб-сайт технической поддержки программного обеспечения компании HP находится по адресу

http://www.hp.com/go/hpsoftwaresupport 

На этом веб-сайте приведена контактная информация и подробные сведения о продуктах, услугах и 
поддержке, предоставляемых компанией HP в сфере программного обеспечения.

Служба поддержки программного обеспечения компании HP в Интернете предоставляет 
заказчикам возможности для самостоятельного устранения неполадок,  а также быстрый и 
эффективный доступ к интерактивным средствам технической поддержки, необходимым для 
управления бизнесом. Наши клиенты, имеющие право на техническую поддержку, могут 
использовать данный веб-сайт для следующих целей:

• Поиск необходимых документов в базе знаний.

• Подача и отслеживание заявок в службу технической поддержки и запросов на расширение 
функциональных возможностей.

• Загрузка исправлений программного обеспечения.

• Управление договорами на оказание поддержки.

• Поиск контактной информации службы поддержки компании HP.

• Просмотр сведений о доступных услугах.

• Участие в обсуждениях с другими покупателями программного обеспечения.

• Поиск курсов обучения по программному обеспечению и регистрация для участия в них.

Для получения доступа к большинству разделов поддержки сначала необходимо 
зарегистрироваться в качестве пользователя службы НР Passport, а затем войти в систему. Для ряда 
разделов поддержки также необходимо наличие договора на оказание поддержки.

Получить более подробные сведения об уровнях доступа можно по адресу:

http://h20230.www2.hp.com/new_access_levels.jsp 

Чтобы зарегистрироваться на получение идентификатора пользователя службы НР Passport, 
перейдите на страницу:

http://h20229.www2.hp.com/passport-registration.html 



5

Оглавление

Введение в учебное руководство ......................................................7
Структура учебного руководства......................................................................... 7
Приступая к работе ............................................................................................ 10
Documentation Library ......................................................................................... 12
Дополнительные сетевые ресурсы ................................................................... 15
Обновление документации ................................................................................ 16

Урок 1: Знакомство с  Quality Center ..............................................17
Процесс управления жизненным циклом приложения .................................... 18
Перед началом работы с Quality Center ........................................................... 19
Окно Quality Center ............................................................................................. 22
Пример веб-сайта Mercury Tours....................................................................... 26

Урок 2: Определение релизов и циклов ........................................31
Определение релизов и циклов ........................................................................ 32
Просмотр релизов и циклов............................................................................... 34

Урок 3: Определение требований ...................................................37
Формулирование требований............................................................................ 38
Просмотр требований ........................................................................................ 43
Преобразование требований............................................................................. 47

Урок 4: Разработка плана тестирования .......................................53
Разработка дерева плана тестирования .......................................................... 54
Разработка шагов теста ..................................................................................... 56
Копирование шагов теста .................................................................................. 60
Вызов тестов с параметрами............................................................................. 61
Сведения о создании и просмотре требований ............................................... 65
Разработка скриптов автоматизированного тестирования............................. 74

Урок 5: Выполнение тестов .............................................................77
Определение набора тестов ............................................................................. 78
Добавление тестов в набор ............................................................................... 86
Составление расписания выполнения тестов ................................................. 89
Выполнение тестов вручную ............................................................................. 98
Просмотр и анализ результатов тестирования.............................................. 105
Автоматическое выполнение тестов............................................................... 110



Оглавление

6

Урок 6: Добавление и отслеживание дефектов .........................113
Отслеживание дефектов ................................................................................. 114
Добавление новых дефектов .......................................................................... 115
Сопоставление дефектов ................................................................................ 118
Обновление дефектов ..................................................................................... 119
Связывание дефектов с тестами .................................................................... 123
Создание избранного представления. ........................................................... 125

Урок 7: Оповещение об изменениях .............................................129
Активация оповещения .................................................................................... 130
Создание напоминаний об исполнении ......................................................... 132

Урок 8: Создание отчетов и диаграмм .........................................135
Создание отчетов............................................................................................. 136
Создание диаграмм ......................................................................................... 144
Создание панелей отчетов.............................................................................. 151

Урок 9: Создание библиотек и базовых состояний...................157
Создание библиотек ........................................................................................ 158
Создание базовых состояний.......................................................................... 160
Сравнение базовых состояний ....................................................................... 163

Урок 10: Настройка проектов ...........................................................169
Начало настройки проекта .............................................................................. 170
Добавление в проект нового пользователя ................................................... 173
Распределение пользователей по группам ................................................... 176
Настройка пользовательского поля................................................................ 178
Создание списка проекта ................................................................................ 181

Урок 11: Заключение .........................................................................185



7

Введение в учебное руководство

Данное учебное руководство представляет собой материалы для 
самостоятельного изучения HP Quality Center — средства управления 
жизненным циклом приложения на основе веб-технологий, разработанного 
компанией HP . 

В этом учебном руководстве вы узнаете, как с помощью Quality Center 
можно упростить организацию и управление всеми этапами жизненного 
цикла приложения, включая определение релизов и требований, 
разработку плана тестирования, выполнение тестов и отслеживание 
дефектов. Вы научитесь созданию базовых состояний для отслеживания 
изменений в проекте и узнаете о способах настройки проектов. 

Чтобы успешно освоить материал данного руководства, необходимо 
изучать его в порядке представленной информации.

Структура учебного руководства 
Учебное руководство состоит из следующих уроков: 

 Урок 1 Знакомство с Quality Center
Знакомит с процессом управления жизненным циклом приложения, а также 
пользовательским интерфейсом Quality Center и примером сайта Mercury 
Tours.

 Урок 2 Определение релизов и циклов
Содержит описание процедуры определения релизов и циклов, методов 
отслеживания хода выполнения и контроля качества.
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 Урок 3 Определение требований
Содержит описание процедуры определения требований, просмотра 
дерева требований, а также преобразования требований в тесты.

 Урок 4 Разработка плана тестирования
В этом уроке рассказывается, как создавать дерево плана тестирования, 
определять шаги тестирования, связывать тесты с требованиями и 
автоматизировать ручные тесты.

 Урок 5 Выполнение тестов
Содержит описание процедур определения наборов тестов, планирования 
выполнения тестов и работы с ручными и автоматизированными тестами.

 Урок 6 Добавление и отслеживание дефектов
Содержит описание процедур добавления новых дефектов, обновления 
дефектов и управления ими.

 Урок 7 Оповещение об изменениях
Содержит описание процедуры отслеживания изменений, внесенных в 
требования, тесты и дефекты в ходе тестирования проекта.

 Урок 8 Создание отчетов и диаграмм
Содержит описание процедуры контроля процесса управления жизненным 
циклом приложения с помощью создания отчетов и диаграмм.

 Урок 9 Создание библиотек и базовых состояний
Содержит описание процедуры создания библиотек и базовых состояний, а 
также сравнения базовых состояний для отслеживания изменений в 
проекте.

 Урок 10 Настройка проектов
Содержит описание настройки пользователей проекта, создания полей и 
списков проекта.
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 Урок 11 Заключение
Содержит сводную информацию о процессе управления жизненным 
циклом приложения в Quality Center и рекомендации для каждой фазы.
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Приступая к работе
Для работы с данным учебным руководством необходимо учесть 
следующее:

Внимание! В уроках руководства используется проект 
QualityCenter_Demo.  Проконсультируйтесь с администратором и 
убедитесь в том, что используется правильная версия проекта 
QualityCenter_Demo. Данная версия распространяется с пакетом 
исправлений Quality Center 10.00 Patch 1 (или выше) и доступна  после 
импорта файла QualityCenter_Demo.qcp с помощью модуля Site 
Administration. Дополнительные сведения см. в документе Руководство по 
установке HP Quality Center.

Спецификации Описание

Выпуски QualityCenter Quality Center поставляется в трех различных 
выпусках  — Starter, Enterprise и Premier. 

В данном учебном руководстве предполагается, 
что вы работаете с выпуском Quality Center 
Enterprise Edition или Quality Center Premier Edition. 
Некоторые уроки и упражнения, использованные в 
данном руководстве, не могут быть выполнены 
при использовании выпуска Quality Center Starter 
Edition. 

Для проверки используемой версии Quality Center 
обратитесь к администратору сайта Quality Center.

QualityCenter_Demo QualityCenter_Demo — демонстрационный проект 
для изучения Quality Center, в котором содержатся 
примеры релизов, требований, тестов, наборов 
тестов, выполнений тестов и дефектов.

Для получения результатов, описанных в данном 
руководстве убедитесь, что использутся новая 
копия проекта QualityCenter_Demo. Для 
получения дополнительных сведений обратитесь к 
администратору сайта Quality Center.
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Mercury Tours. Пример программы, имитирующей сайт для 
бронирования авиабилетов, гостиничных номеров, 
морских путешествий, аренде автомобилей и 
планированию отпусков.

Примечание: Приложение Mercury Tours 
устанавливается во время установки 
Quality Center на сервер. Дополнительные 
сведения см. в документе Руководство по 
установке HP Quality Center.

QuickTest Professional 
или WinRunner

Чтобы выполнить автоматизированные тесты, 
приведенные в настоящем учебном руководстве, 
необходимо установить приложение 
QuickTest Professional или WinRunner.

➤ Для интеграции Quality Center с QuickTest 
Professional необходимо установить надстройки 
HP QuickTest Professional Add-in и 
HP Quality Center Connectivity Add-in, которые 
можно загрузить со страницы надстроек 
HP Quality Center .

➤ Для интеграции Quality Center с WinRunner 
необходимо установить надстройку 
HP Quality Center Connectivity Add-in, которую 
можно загрузить со страницы надстроек 
HP Quality Center.

Дополнительные сведения о надстройках 
Quality Center см. в документе Руководство по 
установке HP Quality Center.

Спецификации Описание
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Documentation Library
Documentation Library — интерактивная справка по  Quality Center. 
Получить доступ к Documentation Library можно следующими способами:

➤ Нажмите кнопку Documentation Library в меню Help Quality Center, чтобы 
открыть главную страницу Documentation Library. На главной странице 
находятся ссылки для быстрого перехода к основным разделам справки.

➤ Выберите элемент Help on this page в меню Help Quality Center, чтобы 
открыть Documentation Library на теме, относящейся к текущей странице.

Руководства Documentation Library
Documentation Library состоит из следующих руководств и справочных 
материалов, которые доступны в Интернете, в электронном виде в 
формате PDF, либо в обоих вариантах. Документы в формате PDF можно 
просматривать и распечатывать в программе Adobe Reader, которую 
можно загрузить с веб-сайта компании Adobe (http://www.adobe.com).

В разделе Getting Started описана процедура использования 
Documentation Library и ее структура. (Доступно в Интернете).

В разделе What’s New? (Новые возможности) содержится описание 
новых функций, добавленных в последнюю версию Quality Center. 
(Доступно в Интернете и в формате PDF).

http://www.adobe.com
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Получить доступ к разделу What’s New? (Новые возможности) также 
можно из меню Help продукта Quality Center. Кроме того, чтобы 
просмотреть короткие ролики, демонстрирующие основные функции 
продукта, выберите Help > Product Feature Movies. 

Файл Readme содержит самые последние новости и сведения о 
Quality Center. 

Руководства Quality Center 
В руководстве пользователя HP Quality Center описано, как с помощью 
Quality Center можно упорядочить и выполнить все этапы процесса 
управления жизненным циклом приложения.   В данном документе 
описано, как определять релизы, разрабатывать требования, планировать 
и выполнять тесты, и отслеживать дефекты. (Доступно в Интернете и в 
формате PDF).

HP Quality Center Administrator Guide содержит описание процедуры 
создания и ведения проектов с помощью функции Site Administration. В нем 
также описано, как настраивать проекты в окне Project Customization. 
(Доступно в Интернете и в формате PDF).

Учебное руководство по HP Quality Centerпредставляет собой 
материалы для самостоятельного изучения использования Quality Center  
для организации процесса управления жизненным циклом программного 
обеспечения. (Доступно в формате PDF).

Руководство по установке HP Quality Center разъясняет процедуру 
установки Quality Center на сервере в кластерной среде или в качестве 
автономного приложения. (Доступно в формате PDF).

Руководство по подготовке к обновлению HP Quality Center содержит 
указания по обнаружению и исправлению проблем перед началом 
обновления проекта.  (Доступно в формате PDF).

HP Quality Center Database Best Practices Guide рассказывается о 
передовых методах развертывания Quality Center на серверах баз данных. 
(Доступно в формате PDF).

Руководства по Business Process Testing
HP Business Process Testing User Guide разъясняет, как использовать HP 
Business Process Testing для создания тестов бизнес-процессов. (Доступно 
в Интернете и в формате PDF).
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Учебное руководство HP Business Process Testing представляет собой 
материалы для самостоятельного изучения основных сведений  об 
использовании  программы HP Business Process Testing в приложении 
Quality Center. (Доступно в формате PDF).

Справочные материалы по интерфейсу прикладного 
программирования (API):
HP Quality Center Database Reference — это полный комплект 
электронной документации по таблицам и полям базы данных проекта. 
(Доступно в Интернете).

HP Quality Center Open Test Architecture API Reference — это полный 
комплект электронной документации по API Quality Center на основе COM. 
Открытую архитектуру тестирования Quality Center можно использовать 
для интеграции средств пользователя по настройке конфигурации, средств 
отслеживания дефектов и пользовательских средств тестирования в 
проекте Quality Center. (Доступно в Интернете).

HP Quality Center Site Administration API Reference — это полный 
комплект электронной документации по API администрирования узлов на 
основе COM. Интерфейс Site Administration API можно использовать для 
того, чтобы приложение выполняло функции упорядочивания, управления 
и ведения пользователей Quality Center, проектов, доменов, подключений и 
параметров конфигурации сайта . (Доступно в Интернете).

HP Quality Center Entity Dependencies API Reference  — доступные в 
Интернете справочные материалы по управлению взаимосвязями между 
объектами Quality Center.  В руководстве описываются API Quality Center на 
базе COM и таблицы данных, которые используются для управления 
взаимосвязями.  Эти справочные материалы пригодятся при интеграции 
средств тестирования и Quality Center. (Доступно в Интернете).

HP Quality Center Custom Test Type Guide — это полное руководство по 
созданию пользовательских средств тестирования и их интеграции в 
продукт Quality Center. (Доступно в Интернете).
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Дополнительные сетевые ресурсы
В меню Help продукта Quality Center доступны следующие дополнительные 
сетевые ресурсы:

 Troubleshooting and Knowledge Base предоставляет доступ к странице 
поиска и устранения неисправностей веб-сайта поддержки программного 
обеспечения НР, на которой можно выполнить поиск в базе знаний для 
самостоятельного устранения неисправностей. Выберите Help > 
Troubleshooting and Knowledge Base. URL-адрес этого веб-сайта: 
http://h20230.www2.hp.com/troubleshooting.jsp.

Пункт меню HP Software Support предоставляет доступ к веб-сайту HP 
Software Support. Этот веб-сайт позволяет осуществлять поиск в базе 
знаний по самостоятельному устранению неисправностей. Кроме того, 
пользователи могут просматривать форумы и оставлять в них сообщения, 
подавать заявки на предоставление поддержки, загружать исправления и 
обновленную документацию, а также выполнять другие операции. 
Перейдите по пунктам меню Help > HP Software Support. Адрес этого веб-
сайта — www.hp.com/go/hpsoftwaresupport.

Для получения доступа к большинству разделов поддержки сначала 
необходимо зарегистрироваться в качестве пользователя службы НР 
Passport, а затем войти в систему. Для ряда разделов поддержки также 
необходимо наличие договора на оказание поддержки.

Получить более подробные сведения об уровнях доступа можно по адресу:  
http://h20230.www2.hp.com/new_access_levels.jsp

Чтобы зарегистрироваться для получения идентификатора пользователя 
службы НР Passport, перейдите на страницу:  
http://h20229.www2.hp.com/passport-registration.html 

Пункт меню HP Software Web site предоставляет доступ к веб-сайту 
программного обеспечения компании НР. На этом веб-сайте приведены 
самые - последние сведения о программных продуктах НР: сведения о 
новых релизах программного обеспечения, семинарах и выставках, 
поддержке клиентов и т.д. Выберите Help > HP Software Web site. Адрес 
этого веб-сайта — www.hp.com/go/software.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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Add-ins Page открывает страницу надстроек HP Quality Center, на которой 
предлагаются решения по интеграции и синхронизации продуктов 
компании HP и вспомогательных программных средств третьих сторон.  
Дополнительные сведения см. в документе Руководство по установке 
HP Quality Center.

Обновление документации
HP Software постоянно обновляет документацию по своим продуктам и 
пополняет ее новыми сведениями..

Чтобы проверить последние обновления или убедиться в том, что вы 
пользуетесь последней редакцией документа, перейдите на веб-сайт HP 
Software Product Manuals (http://h20230.www2.hp.com/selfsolve/manuals).

http://h20230.www2.hp.com/selfsolve/manuals
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Знакомство с  Quality Center

Quality Center обеспечивает организацию всех этапов жизненного цикла 
приложения, включая определение релизов и требований, разработку 
плана тестирования, выполнение тестов и отслеживание дефектов, а также 
управление ими.

Во время этого урока вы узнаете следующее.

 ➤  Процесс управления жизненным циклом приложения на стр. 18

 ➤  Перед началом работы с Quality Center на стр. 19

 ➤  Окно Quality Center на стр. 22

 ➤  Пример веб-сайта Mercury Tours на стр. 26
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Процесс управления жизненным циклом приложения
Процесс управления жизненным циклом приложения с помощью 
Quality Center состоит из следующих этапов:

➤ Определение релизов. Разработка плана управления релизами и 
циклами.

➤ Определение требований.Анализ приложения и определение 
требований.

➤ Планирование тестов. Планирование и утверждение тестов, которые 
необходимо провести, а также выбор способа их выполнения.

➤ Выполнение тестов. Организация наборов тестов, составление 
расписания их выполнения, выполнение тестов и анализ результатов.

➤ Отслеживание дефектов Добавление дефектов, обнаруженных в 
приложении, и отслеживание процесса исправлений.

На всех этапах процесса можно создавать отчеты и диаграммы, которые 
помогут в оценке степени готовности приложения. 
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Перед началом работы с Quality Center
Запуск Quality Center осуществляется в браузере, в строку адреса которого 
вводится URL-адрес HP Quality Center.

Как запустить Quality Center:

 1 Убедитесь, что предварительные требования учебного руководства 
выполнены

Перед началом выполнения уроков данного руководства убедитесь, что 
соответствующие предварительные условия соблюдены. Дополнительные 
сведения см. в разделе “Приступая к работе" на стр. 10.

 2 Откройте окно Options в программе Quality Center.

Откройте браузер и введите URL-адрес Quality Center:
http://<имя сервера Quality Center>[:<номер порта>]/qcbin. Если правильный 
путь не известен, обратитесь к системному администратору.

Откроется окно параметров Quality Center.
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 3 Откройте Quality Center.

Откройте ссылку Quality Center.

При первом запуске Quality Center файлы загружаются на компьютер, и 
выполняется программа установки приложения Microsoft .NET Framework 
2.0 (если оно еще не установлено на компьютере).  После этого 
Quality Center выполнит проверку версии. Если на сервере будет 
обнаружена обновленная версия, файлы обновления будут загружены на 
компьютер.

Откроется окно входа в Quality Center.

 4 Введите имя пользователя и пройдите процедуру аутентификации.

В поле Login Name введите одно из следующих имен: alice_qc, cecil_qc 
или michael_qc.

Пропустите поле Password. Указанным выше пользователям не присвоен 
пароль.
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Нажмите кнопку Authenticate. Quality Center проверит имя пользователя и 
пароль и определит, к каким доменам и проектам вы имеете право доступа.

 5 Войдите в проект.

В списке Domain выберите DEFAULT.

В списке Project выберите QualityCenter_Demo. Если в списке содержится 
несколько проектов QualityCenter_Demo, обратитесь к администратору 
сайта Quality Center, чтобы выяснить, какой проект следует использовать.

Нажмите кнопку Login.

При  первом запуске Quality Center откроется страница Welcome. Со 
страницы Welcome можно перейти непосредственно к этому учебному 
руководству или другой документации по Quality Center. 

После входа в проект откроется главное окно Quality Center и отобразится 
модуль, в котором вы работали в прошлый раз. В правом верхнем углу 
окна отображается имя домена, имя проекта и имя пользователя.
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Окно Quality Center
В этом упражнении вы сможете изучить модули Quality Center и их общие 
элементы. Вы также научитесь работать с интерактивной справкой.

Процедура изучения окна Quality Center.

 1 Изучите модули Quality Center.

Нажмите следующие кнопки на боковой панели:

Кнопка Описание

Модуль Management имеет следующие дочерние модули:

➤ Модуль Releases. Позволяет определять релизы и циклы 
процесса управления приложением.

➤ Модуль Libraries. Позволяет определять библиотеки для 
отслеживания изменений в проекте, применения объектов 
в проекте или повторного использования в нескольких 
проектах.

Quality Center Starter Edition:  Модуль Management не входит в 
состав выпуска Quality Center Starter Edition.

Модуль Requirements  позволяет организовывать требования в 
виде иерархической структуры. Требования можно связывать с 
другими требованиями, тестами или дефектами.

В зависимости от имеющихся лицензий Quality Center можно 
также получить доступ к модулю Business Components. 
Модуль Business Components позволяет специалистам в 
предметной области управлять процессом оптимизации 
качества. Дополнительные сведения см. в документе HP 
Business Process Testing User Guide.

Модуль Test Plan позволяет разрабатывать и упорядочивать 
требования в виде иерархической структуры. Тесты можно 
связывать с требованиями и дефектами.

Модуль Test Resources позволяет организовывать ресурсы 
тестирования в виде иерархической структуры. Ресурсы тестов 
могут быть связаны с тестами.

Модуль Test Lab позволяет тестировать приложение с 
помощью выбранных тестов и анализировать результаты.
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 2 Изучите общие элементы Quality Center.

Все модули Quality Center имеют общие элементы. Например, нажмите 
кнопку Requirements на боковой панели.

Модуль Defects позволяет добавлять дефекты, определять 
приоритеты исправлений, исправлять открытые дефекты и 
анализировать данные.

Модуль Dashboard позволяет создавать диаграммы, отчеты и 
отчеты в формате Excel. Также можно создавать панели 
отчетов, которые позволяют просматривать несколько 
диаграмм одновременно.

Кнопка Описание
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Каждый модуль Quality Center содержит следующие основные элементы:

➤ Общую панель инструментов. Доступ к ней осуществляется из всех 
модулей, и на ней расположены следующие кнопки:

➤ Панель меню модуля. Отображает названия меню команд в текущем 
модуле Quality Center.

➤ Панель инструментов модуля. Расположена под панелью меню. 
Содержит кнопки часто используемых команд текущего модуля 
Quality Center.

 3 Просмотр разделов справки Quality Center.

Для просмотра разделов справки модуля Requirements  нажмите на кнопку 
Requirements на боковой панели. Откроется модуль Requirements. 
Выберите Help > Help on this page. Раздел справки откроется в отдельном 
окне. 

Нажмите кнопку Show Navigation, чтобы открыть панель навигации с 
вкладками Contents, Index, Search и Favorites. Панель навигации будет 
находится в левой части страницы.

Кнопка Описание

Back. Возврат к предыдущему окну Quality Center.

Forward. Переход к следующему окну в Quality Center.

Tools Содержит параметры, которые позволяют выбирать другие 
проекты, настраивать свой проект, добавлять новые дефекты, 
проверять орфографию и грамматику, удалять данные журнала 
из проекта и открывать модуль Document Generator.

Help Позволяет открывать Quality Center Documentation Library и 
дополнительные  ресурсы в Интернете. Кроме того, выводит 
сведения о версии каждого клиентского компонента 
Quality Center. Дополнительные сведения см. в разделах 
“Documentation Library" на стр. 12 и “Дополнительные сетевые 
ресурсы" на стр. 15.

Logout Выход из текущего проекта и переход к окну Quality Center 
Login. 
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Чтобы открыть главную страницу Quality Center Documentation Library, 
нажмите Home на вкладке Contents. Откроется главная страница 
Documentation Library. 

Documentation Library состоит из руководств и справочных материалов, 
доступных в Интернете и/или в формате PDF. 

Нажмите кнопку Close.
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Пример веб-сайта Mercury Tours
Mercury Tours представляет собой пример веб-приложения, используемый 
в данном учебном руководстве. Он имитирует веб-сайт для бронирования 
авиабилетов и гостиничных номеров, аренды автомобилей, морских 
путешествий и планированию отпусков. Прежде чем продолжить работу с 
данным руководством, изучите это приложение.

Для изучения Mercury Tours:

 1 Откройте приложение Mercury Tours.

Откройте еще одно окно браузера и введите следующий URL-адрес: 
http://<имя сервера Quality Center>[:<номер порта>]/mtours

Откроется главная страница Mercury Tours.
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 2 Зарегистрируйтесь в Mercury Tours.

Нажмите Register. Откроется страница регистрации. 

В поле User Information введите любое имя пользователя и пароль и 
подтвердите пароль. (Вводить другую информацию необязательно).

Нажмите кнопку Submit. Mercury Tours подтвердит вашу регистрацию.
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 3 Войдите в Mercury Tours. 

Нажмите кнопку Sign-on. Откроется страница Sign-on. 

Введите имя пользователя и пароль, которые вы использовали при 
регистрации. Нажмите кнопку Submit.
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Откроется страница Flight Finder.

 4 Забронируйте авиабилет. 

Следуйте инструкциям на экране, чтобы забронировать авиабилет. 

 5 Завершите сеанс работы в Mercury Tours. 

Для выхода нажмите кнопку Sign-off.
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2
Определение релизов и циклов

Процесс управления жизненным циклом приложения начинается с 
определения релизов и циклов. Релиз представляет собой группу 
изменений, внесенных в одно или несколько приложений и доступных для 
одновременного распространения.  Каждый релиз может содержать 
несколько циклов. Цикл представляет собой этап разработки и контроля 
качества релиза на основе графика проекта. Как релизы, так и циклы 
имеют определенные даты начала и окончания.

Можно упорядочивать и отслеживать будущие релизы путем определения 
иерархической структуры релиза, которая состоит из релизов и циклов. В 
этом уроке вы добавите релиз в существующее дерево релизов, а затем 
добавите циклы к этому релизу.

Quality Center Starter Edition: Данный урок невозможно выполнить с 
помощью Quality Center Starter Edition.

Во время этого урока вы узнаете следующее.

 ➤  Определение релизов и циклов на стр. 32

 ➤  Просмотр релизов и циклов на стр. 34
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Определение релизов и циклов
В этом упражнении вы определите релиз и затем добавите к нему циклы. 
Релизы и циклы имеют даты начала и окончания. Диапазон дат начала и 
окончания цикла должен находиться в пределах диапазона дат создания и 
окончания соответствующего релиза.

Для определения релиза и его циклов:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Releases.

Нажмите кнопку Management на боковой панели и откройте вкладку 
Releases.

 3 Создайте папку нового релиза.

В дереве релизов выберите корневую папку Releases. Нажмите кнопку 
New Release Folder. Откроется диалоговое окно New Release Folder.

В поле Release Folder Name введите Service Packs.

Нажмите кнопку OK. Папка релиза Service Packs добавится в дерево 
релизов.

В поле Description на правой панели введите следующее описание папки 
релизов: This folder contains service pack releases.

 4 Добавьте релиз.

Убедитесь, что в дереве релизов выбрана новая папка релизов Service 
Packs.

Нажмите кнопку New Release. Откроется диалоговое окно New Release.

В поле Release Name введите Service Pack 1.

Нажмите кнопку OK. Папка релиза Service Pack 1 добавится в папку 
релизов Service Packs.



Урок 2 • Определение релизов и циклов

33

На правой панели в поле Start Date нажмите стрелку «Вниз» и выберите 
вчерашнюю дату. В поле End Date нажмите стрелку «Вниз» и выберите 
дату, которая наступит через 2 месяца после сегодняшнего дня. В поле 
Description введите следующее описание релиза: This release is the first 
service pack release.

 5 Добавьте цикл к релизу.

В дереве релизов выделите релиз Service Pack 1.

Нажмите кнопку New Cycle. Откроется диалоговое окно New Cycle.

В поле Cycle Name введите Cycle 1 - New Features.

Нажмите кнопку OK. Цикл Cycle 1 - New Features добавится к релизу 
Service Pack 1.

На правой панели в поле Start Date нажмите стрелку «Вниз» и выберите 
вчерашнюю дату. В поле End Date нажмите стрелку «Вниз» и выберите 
дату, которая будет через 1 месяц от сегодняшнего дня. В поле Description 
введите следующее описание цикла: This cycle tests new features added for 
this service pack.

 6 Добавьте к релизу второй цикл.

В дереве релизов щелкните релиз Service Pack 1  правой кнопкой мыши и 
выберите New Cycle. Откроется диалоговое окно New Cycle.

В поле Cycle Name введите Cycle 2 - Full.

Нажмите кнопку OK. Цикл Cycle 2 - Full добавится к релизу Service Pack 1.

На правой панели в поле Start Date нажмите стрелку «Вниз» и выберите 
дату, которая наступит через 1 месяц и 1 день после сегодняшнего дня.  В 
поле End Date нажмите стрелку «Вниз» и выберите дату, которая наступит 
через 2 месяца после сегодняшнего дня. В поле Description введите 
следующее описание цикла: This cycle fully tests all application features.
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Просмотр релизов и циклов
Можно просматривать диаграммы и статистические данные, отражающие 
ход работы над релизами и циклами. Данное упражнение позволяет 
ознакомиться с этими диаграммами и статистическими данными. В 
последующих уроках вы увидите, как диаграммы и статистические данные 
изменяются при изменении статуса проекта.

Для просмотра релизов и циклов:

 1 Убедитесь, что модуль Releases открыт.

Если это не так, нажмите кнопку Management на боковой панели и 
откройте вкладку Releases.
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 2 Откройте диаграмму Progress для Service Pack 1.

В дереве релизов выберите релиз Service Pack 1 в папке релизов Service 
Packs. На правой панели перейдите на вкладку Progress.

На вкладке Progress отображаются данные о ходе работы над релизом, в 
том числе покрытие требований, время, прошедшего с даты начала релиза 
и времени, оставшегося до даты окончания, а также количество 
проведенных тестов и тестов, которые еще необходимо выполнить. 
Поскольку требования или тесты еще не созданы, на диаграмме Coverage 
Progress требований указано значение 0%.
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 3 Откройте диаграмму Progress для цикла.

В дереве релизов выберите Cycle 1 - New Features, которая находится в 
папке Service Pack 1. 

На правой панели выберите вкладку Progress. На этой вкладке видно, что 
информация о цикле сходна с информацией о релизе, но на уровне цикла. 
Поскольку требования и тесты для данного релиза еще не созданы, на 
диаграмме Coverage Progress требований указано значение 0%.
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3
Определение требований

В требованиях подробно описывается, какую проблему нужно решить для 
выполнения задач разрабатываемого приложения.

Задать требования в Quality Center можно путем создания дерева 
требований в модуле Requirements. Дерево требований является 
графическим представлением описания требований и отображает 
требования в виде иерархической структуры. Можно группировать и 
сортировать требования в дереве, отслеживать ход выполнения 
требований и создавать подробные отчеты и диаграммы. В данном уроке 
вы создадите требования в существующем дереве требований.  Затем вы 
назначите требования циклу в дереве релизов. 

Во время этого урока вы узнаете следующее.

 ➤  Формулирование требований на стр. 38

 ➤  Просмотр требований на стр. 43

 ➤  Преобразование требований на стр. 47
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Формулирование требований
В ходе этого упражнения вы сформулируете требования к тестированию 
функциональных возможностей приложения для бронирования круизов на 
сайте Mercury Tours. 

Quality Center Starter Edition: В выпуске Quality Center Starter Edition 
создание нескольких типов требований не поддерживается. Также 
недоступны некоторые поля и команды, относящиеся к циклам и релизам.

Чтобы сформулировать требования:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Requirements.

Нажмите кнопку Requirements на боковой панели.

Выберите View > Requirements Tree, чтобы отобразить требования в виде 
дерева.

 3 Выберите требование Mercury Tours Application .

Разверните корневой каталог Requirements и выберите требование 
Mercury Tours Application. 

 4 Создайте новое требование и назначьте соответствующий ему тип 
требований.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 5 на стр. 40.
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Нажмите кнопку New Requirement. Откроется диалоговое окно Create New 
Requirement.

В поле Requirement Type выберите Functional. Каждое требование 
относится к определенному типу требований. Тип требований, к которому 
относится требование, определяет, какие поля доступны для него. 
Администратор проекта может изменять существующие типы и добавлять 
новые.

В поле Requirement Name введите Cruise Reservation.

Нажмите кнопку OK. Откроется диалоговое окно New Requirement.
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 5 Quality Center Starter Edition: Создайте новое требование.

Этот шаг используется только при работе с Quality Center Starter Edition.

Нажмите кнопку New Requirement. Откроется диалоговое окно New 
Requirement.

В поле Requirement Name введите Cruise Reservation.

 6 Добавьте к требованию подробные сведения.

Введите или выберите следующее: 

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Reservation добавится к 
требованиям в дереве Mercury Tours Application.

Нажмите кнопку Close, чтобы закрыть диалоговое окно New Requirement.
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 7 Создайте дочернее требование и назначьте ему тип требований.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 8.

Убедитесь, что в дереве требований выбрано новое требование Cruise 
Reservation.

Нажмите кнопку New Requirement, чтобы добавить требование после 
Cruise Reservation. 

В диалоговом окне Create New Requirement выберите Functional в поле 
Requirement Type и введите Cruise Search в поле Requirement Name. 
Нажмите кнопку OK. Откроется диалоговое окно New Requirement.

Введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Search добавится в качестве 
дочернего требования к требованию Cruise Reservation. Нажмите кнопку 
Close, чтобы закрыть диалоговое окно New Requirement.

 8 Quality Center Starter Edition: Добавьте дочернее требование.

Этот шаг используется только при работе с Quality Center Starter Edition.

Убедитесь, что в дереве требований выбрано новое требование Cruise 
Reservation.

Нажмите кнопку New Requirement, чтобы добавить требование после 
Cruise Reservation. 

В диалоговом окне New Requirement в поле Requirement Name введите 
Cruise Search.

Введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Search добавится в качестве 
дочернего требования к требованию Cruise Reservation. Нажмите кнопку 
Close, чтобы закрыть диалоговое окно New Requirement.
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 9 Добавьте дочернее требование Cruise Booking.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 10.

Убедитесь, что в дереве требований выбрано требование Cruise 
Reservation.

Нажмите кнопку New Requirement, чтобы добавить требование после 
Cruise Reservation. 

В диалоговом окне Create New Requirement выберите Functional в поле 
Requirement Type и введите Cruise Booking в поле Requirement Name. 
Нажмите кнопку OK. Откроется диалоговое окно New Requirement.

Введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Booking добавится в качестве 
дочернего к требованию Cruise Reservation. Нажмите кнопку Close, чтобы 
закрыть диалоговое окно New Requirement.

 10 Quality Center Starter Edition: Добавьте дочернее требование Cruise 
Booking.

Этот шаг используется только при работе с Quality Center Starter Edition.

Убедитесь, что в дереве требований выбрано требование Cruise 
Reservation.

Нажмите кнопку New Requirement, чтобы добавить требование после 
Cruise Reservation. 

В диалоговом окне New Requirement в поле Requirement Name введите 
Cruise Booking.

Введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Booking добавится в качестве 
дочернего к требованию Cruise Reservation. Нажмите кнопку Close, чтобы 
закрыть диалоговое окно New Requirement.
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 11 Присвойте требование циклу.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, пропустите этот шаг.

В дереве требований выберите Cruise Reservation.

Выберите Requirements > Assign to cycle. Откроется дерево релизов. В 
папке релизов Service Packs, релизе Service Pack 1 установите флажок 
для цикла Cycle 1 - New Features. 

Чтобы закрыть дерево релизов, нажмите кнопку OK. 

Нажмите кнопку Yes, чтобы назначить цикл требованию и его дочерним 
требованиям.

Просмотр требований
Способ отображения требований можно изменить. В ходе этого 
упражнения вы научитесь увеличивать и уменьшать размер дерева 
требований, а также узнаете о способах отображения и фильтрации 
требований в таблице требований.

Порядок просмотра требований.

 1 Убедитесь, что модуль Requirements открыт.

Если это не так, нажмите кнопку Requirements на боковой панели. 

Выберите View > Requirements Tree для отображения требований в 
представлении Requirements Tree.

 2 Увеличьте и уменьшите размер дерева требований.

В дереве требований выберите Cruise Reservation.
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Для увеличения нажмите кнопку Zoom In на панели инструментов. Дерево 
требований отображает только дочерние требования Cruise Reservation.

Чтобы произвести действие, обратное увеличению, и отобразить все 
дерево требований, нажмите стрелку Zoom In и выберите Zoom Out To 
Root.

 3 Просмотр требований в таблице требований.

Выберите View > Requirements Grid для отображения требований в 
сплошном неиерархическом виде. В каждой строке таблицы отображается 
отдельное требование.
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 4 Задайте фильтр для просмотра требований, созданных в конкретную 
дату.

Нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 
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В поле Creation Date нажмите Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition, отображающее 
сегодняшнее число в календаре.

Выберите дату добавления требований. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы применить выбранный фильтр.

В таблице Requirements Grid отображаются добавленные требования.
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Преобразование требований
После создания дерева требований используйте требования в качестве 
основы для определения дерева плана тестирования в модуле Test Plan. 
Дополнительные сведения см. в уроке “Разработка плана тестирования" на 
стр. 53.

Для разработки дерева плана тестирования можно использовать мастер 
Convert to Tests. Данный мастер позволяет преобразовывать выбранные 
требования или все требования в дереве требований в элементы или 
тесты в дереве плана тестирования.

В этом упражнении вы сможете преобразовать требование Cruise 
Reservation в предмет дерева плана тестирования, а дочернее требование 
Cruise Reservation в тесты тематической папки Cruise Reservation. 

Для преобразования требования:

 1 Убедитесь, что модуль Requirements открыт.

Если это не так, нажмите кнопку Requirements на боковой панели.

Выберите View > Requirements Tree для отображения требований в 
представлении Requirements Tree.

 2 Выберите требование.

В дереве требований выберите Cruise Reservation. 
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 3 Запустите мастер Convert to Tests.

Выберите Requirements > Convert to Tests. Откроется диалоговое окно 
Step 1.

 4 Выберите автоматическое преобразование.

Выберите второй параметр Convert lowest child requirements to tests, 
чтобы преобразовать выделенное требование в тематическую папку, а 
дочерние требования — в тесты.
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 5 Начните процесс преобразования.

Нажмите кнопку Next , чтобы начать преобразование требований. По 
окончании процесса преобразования результаты будут выведены в 
диалоговом окне Step 2.
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Нажмите кнопку Next. Откроется диалоговое окно Step 3.

 6 Выберите путь к тематической папке.

В поле Destination Subject Path нажмите кнопку обзора. Откроется 
диалоговое окно Select Destination Subject.

Если были применены какие-либо фильтры нажмите стрелку Set Filter/Sort 
и выберите Clear Filter/Sort. Нажмите кнопку Yes для подтверждения.
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В дереве плана тестирования выберите раздел Cruises.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Destination 
Subject. В поле Destination Subject Path теперь отображается следующий 
путь:

 7 Завершите процесс преобразования.

Нажмите кнопку Finish. Нажмите кнопку OK.

 8 Просмотрите тесты в дереве плана тестирования.

Для отображения модуля Test Plan нажмите кнопку Test Plan на боковой 
панели.

В дереве плана тестирования разверните Cruises. В дереве плана 
тестирования отобразится Cruise Reservation под Cruises. 
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Разверните Cruise Reservation. В дереве плана тестирования откроются 
тесты Cruise Booking и Cruise Search.
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4
Разработка плана тестирования

После разработки требований необходимо определить цель тестирования 
и разработать стратегию для ее достижения. 

После определения цели тестирования создается дерево плана 
тестирования, позволяющее иерархически разделить приложение на 
тестируемые модули или объекты. Для каждого объекта на дереве плана 
тестирования определяются тесты, состоящие из шагов.

Каждый шаг теста должен содержать описание действий, которые 
необходимо выполнить с приложением, и ожидаемый результат. 
Универсальность шага теста можно повысить путем добавления 
параметров.

Для отслеживания отношений можно добавить связь между тестами и 
требованиями. Это поможет обеспечить соответствие требованиям в 
течение всего процесса управления жизненным циклом приложения. 

После разработки тестов можно выбрать тесты для автоматизации. В 
рамках автоматизации теста можно создать скрипт тестирования, а затем 
дополнить его другим средством тестирования HP (например, QuickTest 
Professional или WinRunner).

Во время этого урока вы узнаете следующее.

 ➤  Разработка дерева плана тестирования на стр. 54

 ➤  Разработка шагов теста на стр. 56

 ➤  Копирование шагов теста на стр. 60

 ➤  Вызов тестов с параметрами на стр. 61

 ➤  Сведения о создании и просмотре требований на стр. 65
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 ➤  Разработка скриптов автоматизированного тестирования на стр. 74

Разработка дерева плана тестирования
Как правило, приложение слишком велико, чтобы тестировать его целиком. 
Модуль Test Plan позволяет разбить приложение на функциональные 
составляющие. Эти фрагменты называются модулями или объектами. Они 
создаются вместе с деревом плана тестирования. Дерево плана 
тестирования — это графическое представление плана тестирования, 
отображающее тесты в соответствии с иерархическими взаимосвязями 
между их функциями. Определив объекты на дереве, решите, какие тесты 
нужно создать для этих объектов, а затем добавить тесты на дерево.

На уроке 3 вы преобразовали требование Cruise Reservation и его 
дочерние требования в объекты и тесты на дереве плана тестирования 
(см. раздел “Преобразование требований" на стр. 47). В ходе этого 
упражнения вы добавите объект и тест к дереву плана тестирования в 
модуле Test Plan.

Чтобы разработать дерево плана тестирования:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

 3 Добавьте папку объектов в дерево плана тестирования.

Выберите папку объектов Cruises и нажмите кнопку New Folder. Откроется 
диалоговое окно New Folder.

В поле Folder Name введите Cruise Cancellation. Нажмите кнопку OK. На 
дереве плана тестирования под папкой Cruises появится созданная папка 
объектов. 

На правой панели на вкладке Description введите описание объекта. This 
folder contains tests that verify the Cancel Reservation functionality.
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 4 Добавьте тест в папку объектов.

Выберите папку Cruise Cancellation и нажмите кнопку New Test. Откроется 
диалоговое окно Create New Test.

В поле Test Type выберите QUICKTEST_TEST для создания теста 
QuickTest Professional или выберите WR-AUTOMATED для создания теста 
WinRunner. 

В поле Test Name введите имя теста: Cancel All Reservations. 

Нажмите кнопку OK. Откроется диалоговое окно Required Test Fields.

Установите следующие значения:

Level: Basic 

Reviewed: Not Reviewed

Priority: 4-Very High
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Нажмите кнопку OK. Новый тест появится в дереве плана тестирования 
под папкой объекта Cruise Cancellation.

 5 Добавьте описание теста.

На вкладке Details можно увидеть имя теста, автора, дату создания, статус 
теста и другую информацию.

На вкладке Description введите описание теста: The test verifies 
cancellation of cruise reservations in the Itinerary page.

Разработка шагов теста
После добавления теста в дерево плана тестирования и задания базовой 
информации о тесте составляются шаги теста, которые представляют 
собой пошаговые инструкции по проведению теста. Шаг содержит 
описание действий, которые необходимо выполнить с приложением, и 
ожидаемых результатов.

Шаги теста можно создавать как для ручных, так и автоматизированных 
тестов. Для ручных тестов планирование теста заключается в разработке 
шагов теста. Используя план, можно сразу же начинать выполнение теста. 
Для автоматизированных тестов создаются скрипты автоматического 
тестирования с использованием средств тестирования HP, 
пользовательских средств тестирования или средств тестирования 
сторонних- производителей. 

В этом упражнении вы сможете создать тест Cruise Booking. Этот тест 
проверяет процесс бронирования круиза на сайте Mercury Tours. 
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Чтобы разработать шаг теста:

 1 Убедитесь, что открыт модуль Test Plan.

Если это не так, нажмите кнопку Test Plan на боковой панели. 

 2 Откройте тест Cruise Booking.

Разверните папки объектов Cruises и Cruise Reservation и выделите тест 
Cruise Booking.

 3 Откройте редактор Design Step Editor.

Перейдите на вкладку Design Steps.

Нажмите кнопку New Step. Откроется редактор Design Step Editor. 

В поле Step Name появится имя шага. По умолчанию имя представляет 
собой порядковый номер шага теста (Step 1, если шаги добавляются к 
тесту впервые). 

 4 Создайте шаг для отображения страницы Cruise Special.

В редакторе Design Step Editor введите следующую информацию:

Step Name: Display the Cruise Special page. 

Description: Click the Cruises button. 
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Expected Result: The Cruise Special page opens. 

 5 Создайте шаг для бронирования круиза.

Убедитесь, что предыдущий шаг выбран в редакторе Design Step Editor.

Нажмите кнопку New Step. В поле Step Name отобразится Step 2.

Введите следующее:

Step Name: Display the Cruise Reservation page.

Description: Click the Now Accepting Reservations button.

Expected Result: The Cruise Reservation page opens.

 6 Создайте шаг для заказа билетов на круиз.

Убедитесь, что предыдущий шаг выбран в редакторе Design Step Editor.

Нажмите кнопку New Step. В поле Step Name отобразится Step 3.

Введите следующее:

Step Name: Book the cruise.

Description: Enter passenger name, credit card information, and address. Click 
OK. 

Expected Result: The Cruise Confirmation page opens.

 7 Создайте шаг для печати подтверждения информации по круизу.

Убедитесь, что предыдущий шаг выбран в редакторе Design Step Editor.

Нажмите кнопку New Step. В поле Step Name отобразится Step 4.

Введите следующее:

Step Name: Print cruise confirmation.

Description: Click the Print button. 

Expected Result: A confirmation page is printed.

 8 Создайте шаг для выхода с сайта Mercury Tours.

Убедитесь, что предыдущий шаг выбран в редакторе Design Step Editor.

Нажмите кнопку New Step. В поле Step Name отобразится Step 5.

Введите следующее:
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Step Name: Log off.

Description: Click the Sign-Off button. 

Expected Result: Returns to the Sign-On page.

 9 Закройте редактор Design Step Editor.

Нажмите кнопку OK. На вкладке Design Steps отобразятся созданные шаги.
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Копирование шагов теста
Можно копировать шаги теста в одном проекте или из одного проекта в 
другой. В этом упражнении вы скопируете шаги из теста Cruise Booking и 
вставите их в тест Cruise Search. 

Порядок копирования шага теста.

 1 В тесте Cruise Booking выберите вкладку Design Steps.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Booking.

Перейдите на вкладку Design Steps.

 2 Выберите шаги, которые нужно скопировать.

Наведите курсор мыши на серую боковую панель слева. Курсор изменится 
на стрелку. Нажмите кнопку SHIFT или CTRL и выделите каждую строку.
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 3 Скопируйте выделенные шаги.

Нажмите кнопку Copy Steps.

 4 Вставьте шаги в тест Cruise Search.

В дереве плана тестирования выберите тест Cruise Search.

На вкладке Design Steps нажмите кнопку Paste Steps. Шаги теста будут 
скопированы на вкладку Design Steps.

Вызов тестов с параметрами
Для увеличения гибкости ручных тестов можно добавить параметры к 
шагам теста. Это позволяет запускать один и тот же тест несколько раз с 
разными данными. Параметр теста — это переменная, которой 
присваивается значение вне теста, в котором она была определена.

Ручные тесты с параметрами можно вызывать из других тестов. Это 
удобно при наличии общих шагов, которые требуется часто выполнять в 
рамках других тестов. Например, можно создать шаблон теста 
Login_Template, который выполняет вход пользователя в систему при 
запуске приложения. Необходимо вызывать этот тест в начале каждого 
теста. В некоторых случаях необходимо входить в систему с правами 
обычного  пользователя, в других случаях — с правами администратора 
проекта.

Для этого следует создать два параметра: <<<user name>>> и 
<<<password>>> и изменить их значения в зависимости от типа теста, 
вызывающего Login_Template. Если чаще всего выполняется вход в 
систему с именем обычного пользователя, можно присвоить этим 
параметрам значения по умолчанию, соответствующие имени и паролю 
обычного пользователя. 

В разделе “Разработка шагов теста" на стр. 56 вы создали тест для заказа 
билетов на круиз. В этом упражнении вы сможете усовершенствовать свой 
тест, запустив тест Connect And 
Sign-On. Этот тест-шаблон содержит параметры для URL-адреса Mercury 
Tours и имени пользователя и пароля, которые используются для входа на 
сайт.
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Для вызова теста с параметрами:

 1 В тесте Cruise Booking выберите вкладку Design Steps.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Booking.

Перейдите на вкладку Design Steps.

 2 Выберите тест с параметрами, который нужно вызвать.

Нажмите кнопку Call to Test. Откроется диалоговое окно Select a Test.

В поле Find введите Connect и нажмите кнопку Find. Будет выделен тест 
Connect And Sign-On.
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Нажмите кнопку OK. Открывает диалоговое окно Parameters of Test, в 
котором отображаются параметры вызванного теста.

 3 Присвойте параметрам фактические значения.

В столбце Actual Value введите следующее:

user name: Свое имя пользователя. Используйте имя, которое 
применялось в Mercury Tours. Дополнительные сведения см. в разделе 
“Пример веб-сайта Mercury Tours" на стр. 26.

mercury tours url: http://<имя сервера Quality Center>[:<номер 
порта>]/mtours

password: Оставьте пустым. Этому параметру присваивается значение во 
время выполнения теста (см. раздел “Выполнение тестов вручную" на 
стр. 98).

Нажмите кнопку OK. Шаг Call <Connect And Sign-On> добавлен к шагам 
проекта.
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 4 Измените последовательность шагов.

Наведите курсор мыши на серую боковую панель слева от шага 
Call Connect And Sign-On. Курсор изменится на стрелку. Нажмите и 
перетащите шаг в верхнюю строку.
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Сведения о создании и просмотре требований
Необходимо, чтобы тесты в плане тестирования соответствовали 
требованиям. Для обеспечения соответствия требованиям на всех этапах 
процесса управления жизненным циклом приложения можно добавлять 
связи между тестами модуля Test Plan и требованиями модуля 
Requirements.

В модуле Test Plan создается покрытие требований путем выбора 
требований для связи с тестом. В качестве альтернативного варианта в 
модуле Requirements можно создать покрытие тестами путем выбора 
теста для связи с требованием. Тест может покрывать несколько 
требований, а требование может покрываться несколькими тестами.

После регистрации дефектов в целях обеспечения дальнейшего 
соответствия требованиям к тестированию можно связать требования и 
тесты для дефектов (см. раздел “Связывание дефектов с тестами" на 
стр. 123). Это гарантирует, что при изменении какого-либо требования 
можно определить, какие тесты и дефекты будут затронуты, и кто за это 
несет ответственность.

В ходе этих упражнений вы узнаете о следующем.

➤ Связывание требований с тестами

➤ Связывание тестов с требованием

➤ Анализ покрытия тестами

Связывание требований с тестами
В этом упражнении можно будет увидеть существующее покрытие 
требований тестом Cruise Booking и создать новое покрытие требований, 
установив связь между требованием Cruise Search и тестом Cruise 
Booking. 

Вы также добавите покрытие требований к следующим тестам: Cancel All 
Reservations, Airline Preference и Number of Passengers.



Урок 4 • Разработка плана тестирования

66

Чтобы связать требование с тестом:.

 1 Убедитесь, что открыт модуль Test Plan.

Если это не так, нажмите кнопку Test Plan на боковой панели. 

 2 Откройте тест Cruise Booking.

Разверните папки объектов Cruises и Cruise Reservation и выделите тест 
Cruise Booking.

 3 Откройте вкладку Req Coverage.

На правой панели выберите вкладку Req Coverage. Существующий 
покрытие требований отобразится в таблице. Обратите внимание, что 
требование Cruise Booking уже связано с тестом Cruise Booking, 
поскольку вы преобразовали требование в тест (см. раздел 
“Преобразование требований" на стр. 47).

 4 Откройте дерево требований.

Нажмите кнопку Select Req и разверните дерево требований, 
отображенное справа.
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 5 Добавьте в таблицу требование Cruise Search.

В дереве требований на правой панели под Cruise Reservation выберите 
Cruise Search. 

Нажмите кнопку Add to Coverage (Without Children). Требование Cruise 
Search будет добавлено в таблицу покрытия требований. 

Совет: Требование также можно перетащить из дерева требований в 
таблицу покрытия требований. Требование будет добавлено в таблицу 
покрытия без дочерних требований.

 6 Добавьте покрытие требований к тесту Cancel All Reservations.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Cancellation и выделите тест Cancel All Reservations.

В дереве требований на правой панели под Cruise Reservation выберите 
Cruise Search и перетащите требование в таблицу покрытия. Выделите 
Cruise Booking и перетащите требование в таблицу покрытия требований.

 7 Добавьте покрытие требований к тесту Airline Preference.

В дереве плана тестирования разверните папки объектов Flight 
Reservation и Flight Finder и выделите тест Airline Preference.

В дереве требований на правой панели под Cruise Reservation выберите 
Cruise Search и перетащите требование в таблицу покрытия. Выделите 
Cruise Booking и перетащите требование в таблицу покрытия требований.

 8 Удалите покрытие требований из теста Airline Preference.

В таблице покрытия требований выберите Flight Tickets. Нажмите кнопку 
Remove Selected. Нажмите кнопку Yes для подтверждения.

Выделите Airline Company и нажмите кнопку Remove Selected. Нажмите 
кнопку Yes для подтверждения.

 9 Добавьте покрытие требований к тесту Number of Passengers.

В дереве плана тестирования разверните папки объектов Flight 
Reservation и Flight Finder и выделите тест Number of Passengers.
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В дереве требований на правой панели под Cruise Reservation выберите 
Cruise Search и перетащите требование в таблицу покрытия. 

 10 Скройте дерево требований.

Нажмите кнопку Close.

Связывание тестов с требованием
В этом упражнении вы сможете создать покрытие тестами путем 
связывания теста Cruise Search с требованием Cruise Booking.

Чтобы связать тест с требованием:

 1 Откройте модуль Requirements.

Нажмите кнопку Requirements на боковой панели. 

 2 Откройте дерево требований в виде Requirement Details View.

Выберите View > Requirement Details. Откроется представление 
Requirements Details.

 3 Откройте требование Cruise Booking.

В дереве требований разверните папку Cruise Reservation и выберите 
требование Cruise Booking.

 4 Перейдите на вкладку Test Coverage.

На правой панели щелкните вкладку Test Coverage. В таблице покрытия 
требований показано, что требование Cruise Booking уже связано со 
следующими тестами: Cruise Booking, Cancel All Reservations и Airline 
Preference.
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 5 Откройте дерево плана тестирования.

Если дерево плана тестирования не отображается, нажмите кнопку Select 
Tests на вкладке Test Coverage для отображения дерева плана 
тестирования справа.

 6 Выберите тест Cruise Search в дереве плана тестирования.

На вкладке Test Plan Tree разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Search.

 7 Добавьте тест в таблицу покрытия.

Нажмите кнопку Add to Coverage. Тест Cruise Search будет добавлен в 
таблицу покрытия. 

Совет: Тест или папку объектов также можно перетащить из дерева плана 
тестирования в таблицу покрытия.

 8 Скройте дерево плана тестирования.

Нажмите кнопку Close над деревом плана тестирования.
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Анализ покрытия тестами
После создания покрытия тестами можно использовать окно Coverage 
Analysis модуля Requirements для анализа схемы организации дочерних 
требований в соответствии с тестовым покрытием. 

В этом упражнении вы проанализируете требование Application Client 
System.

Чтобы проанализировать покрытие тестом:

 1 Убедитесь, что открыт модуль Requirements.

Если это не так, нажмите кнопку Requirements на боковой панели.

 2 Откройте дерево требований в представлении Coverage Analysis.

Выберите View > Coverage Analysis. Отобразится представление 
Coverage Analysis. 

 3 Откройте требование Application Client System в представлении 
Coverage Analysis.

Если были применены какие-либо фильтры нажмите стрелку Set Filter/Sort 
и выберите Clear Filter/Sort. Нажмите кнопку Yes для подтверждения.
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Под требованием Mercury Tours Application разверните требование 
Application Client System и его производные.

В столбце Coverage Analysis можно увидеть какие дочерние требования 
имеют статус прямого покрытия, а какие этого статуса не имеют. 

 4 Откройте анализ покрытия для требования Application Client System.

Правой кнопкой мыши щелкните требование Application Client System и 
выберите Coverage Analysis. Откроется диалоговое окно Coverage 
Analysis.
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 5 Откройте дочерние требования со статусом «Failed».

Щелкните красную область Failed диаграммы. Будут перечислены 
дочерние требования со статусом «Failed».



Урок 4 • Разработка плана тестирования

73

 6 Откройте покрытие тестами для данного требования.

Щелкните ссылку Show Tests Coverage, чтобы расширить диалоговое окно 
Coverage Analysis, содержащее диаграмму покрытия тестами. 

Эта круговая диаграмма графически отображает полное покрытие 
требования тестами, сгруппированными по статусу.

В диаграмме щелкните сегмент Passed, чтобы открыть диалоговое окно 
Tests Coverage и отобразить список тестов с выбранным статусом. 
Закройте диалоговое окно Test Coverage.

 7 Закройте диалоговое окно Coverage Analysis.

Нажмите кнопку Close. 
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Разработка скриптов автоматизированного тестирования
При разработке плана тестирования следует решить, какие тесты должны 
быть автоматизированы. Если будет принято решение выполнять тесты 
вручную, тесты будут готовы к выполнению сразу после определения 
шагов тестирования. Если будет принято решение об автоматизации теста, 
можно создать скрипты тестирования, а затем дополнить их другими 
средствами тестирования HP (например, QuickTest Professional или 
WinRunner).

Рассмотрите эти вопросы в процессе принятия решения об автоматизации 
теста.

В этом упражнении вы научитесь создавать скрипт автоматизированного 
тестирования для теста Address Options.

Чтобы разработать скрипт автоматизированного тестирования:

 1 Откройте модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

 2 Найдите ручной тест Address Options.

Выберите корневую папку Subject дерева плана тестирования и выберите 
Edit > Find. Откроется диалоговое окно Find Folder/Test.

Автоматизировать: ➤ Тесты, которые выполняются для каждой новой 
версии приложения, чтобы проверить стабильность 
основных функциональных возможностей всего 
приложения (регрессионные тесты). 

➤ Тесты, использующие несколько значений для одной 
и той же операции (тесты, определяемые данными). 

➤ Тесты, которые выполняются многократно (стресс-
тесты), а также тесты, проверяющие 
многопользовательскую систему клиент-сервер 
(тесты на нагрузку ). 

Не 
автоматизировать:

➤ Тесты, выполняемые только один раз
➤ Тесты, требующие немедленного выполнения.
➤ Тесты на удобство использования приложения.
➤ Тесты с непредсказуемыми результатами.
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В поле Value To Find, введите Book.

Для поиска папок и тестов установите флажок Include Tests.

Нажмите кнопку Find. Откроется диалоговое окно Search Results со 
списком возможных совпадений.

Дважды щелкните папку Flight Reservation\Book Flight для выделения 
теста в дереве плана тестирования. Нажмите кнопку Close, чтобы закрыть 
диалоговое окно Search Results.

В дереве плана тестирования выберите раздел Address Options.

 3 Откройте вкладку Design Steps.

На правой панели щелкните вкладку Search Results.

 4 Создайте скрипт тестирования.

Нажмите кнопку Generate Script.

Выберите QUICKTEST_TEST для создания теста с помощью средства 
тестирования QuickTest Professional или WR-AUTOMATED для создания 
теста с помощью WinRunner.

Шаги теста Address Options используются для создания скрипта 
автоматизированного тестирования. В дереве плана тестирования ручные 
тесты со значком шагов  заменяются на значок автоматического теста.

 5 Просмотрите скрипт тестирования.

Перейдите на вкладку Test Script.

Чтобы отобразить и изменить скрипт тестирования в средствах 
тестирования, в которых он был создан, нажмите кнопку Launch.
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5
Выполнение тестов

В процессе управления жизненным циклом приложения можно запускать 
ручные и автоматические тесты для поиска дефектов и оценки качества 
приложения.

Все начинается с создания наборов тестов и выбора тестов для 
включения в каждый набор. Набор тестов представляет собой группу 
тестов в проекте Quality Center, разработанную для достижения конкретных 
задач тестирования. Quality Center позволяет контролировать выполнение 
тестов из набора путем задания условий тестирования и планирования 
выполнения тестов.

После определения наборов тестов можно приступить к выполнению 
тестов. Для просмотра и анализа результатов тестирования можно 
использовать Quality Center.

При выполнении теста вручную пользователь выполняет шаги теста, 
которые были определены в плане тестирования. Результат выполнения 
каждого шага теста зависит от того, соответствуют ли фактические 
результаты тестирования ожидаемым. Если выполняется 
автоматизированный тест, Quality Center открывает выбранное средство 
тестирования, запускает тест, а затем импортирует результаты 
тестирования в Quality Center.

Во время этого урока вы узнаете следующее.

 ➤  Определение набора тестов на стр. 78

 ➤  Добавление тестов в набор на стр. 86

 ➤  Составление расписания выполнения тестов на стр. 89

 ➤  Выполнение тестов вручную на стр. 98

 ➤  Просмотр и анализ результатов тестирования на стр. 105
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 ➤  Автоматическое выполнение тестов на стр. 110

Определение набора тестов
После разработки тестов в модуле Test Plan можно создать дерево 
наборов тестов. Наборы тестов позволяют организовать процесс 
тестирования путем объединения наборов тестов в соответствующих 
папках и распределения их по иерархическим уровням в модуле Test Plan. 
Каждая папка наборов тестов назначается циклу. Это позволяет 
группировать наборы тестов, которые будут выполняться во время одного 
цикла, и анализировать прогресс цикла по мере выполнения тестов.

Набор тестов может содержать как ручные, так и автоматизированные 
тесты. Можно также включать экземпляры одного теста в различные 
наборы тестов, причем в один набор тестов можно включать несколько 
экземпляров одного и того же теста.

При создании наборов тестов необходимо учитывать цели, которые были 
сформулированы в начале процесса управления жизненным циклом 
приложения.  Следует учитывать такие вопросы, как текущее состояние 
приложения, добавление новых и модификация существующих функций.
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Ниже приведены примеры общих категорий наборов тестов, которые 
можно создавать.

В этом упражнении вы создадите набор тестов для сайта Mercury Tours. 
Кроме того, вы зададите правила ошибки для набора тестов с 
инструкциями для Quality Center, которые должны выполняться в случае 
отрицательного результата автоматизированного теста из набора.

Набор тестов Описание

Работоспособность Проверяет приложение в целом на базовом уровне, 
его работоспособность и стабильность. При этом 
главное внимание уделяется широте, а не глубине 
проверки. Этот набор тестов содержит основные 
тесты, в том числе положительные проверки, которые 
показывают, что приложение работает правильно.  
Например, при проверке Mercury Tours можно 
проверить открытие приложения и возможность входа 
в него.

Регрессия Система тестируется глубже, чем при поверхностной 
проверке работоспособности. Этот набор тестов 
содержит как "положительные", так и "отрицательные" 
проверки. Отрицательное тестирование представляет 
собой попытку вызвать сбой в приложении, чтобы 
продемонстрировать его неправильную работу.

Расширенный Приложение тестируется как в ширину, так и в 
глубину. Этот набор тестов позволяет проверить все 
приложение, в том числе его расширенные функции. 
Выполнить этот набор тестов можно в случае, если на 
тестирование выделено достаточно много времени.

Функциональность Тестируется подсистема приложения. Это может быть 
одна функция или группа функций. Например, при 
проверке приложения Mercury Tours можно проверить 
все действия, связанные с бронированием билетов на 
авиарейс.
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Quality Center Starter Edition: Поля и команды, относящиеся к циклам и 
релизам, недоступны в Quality Center Starter Edition.

Процедура определения набора тестов.

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Test Lab.

Нажмите кнопку Test Lab на боковой панели.

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 3 Добавьте папку в дерево наборов тестов.

В дереве наборов тестов на левой панели выберите папку Root.

Нажмите кнопку New Folder. Откроется диалоговое окно New Folder.

В поле Folder Name введите Service Pack 1 и нажмите OK.

 4 Создайте вложенные папки в папке с наборами тестов.

Выделите созданную папку Service Pack 1 и повторите предыдущий шаг 
для создания двух вложенных папок с именами Cycle 1 - New Features и 
Cycle 2 - Full.

 5 Назначьте папку наборов тестов циклу.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 6.

Выделите папку с набором тестов Cycle 1 - New Features и нажмите кнопку 
Assign to Cycle. Откроется диалоговое окно Assign to Cycle. 

В папке релизов Service Packs релизе Service Pack 1 выделите цикл Cycle 
1 - New Features. 
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Нажмите кнопку OK. Значок папки в дереве наборов тестов изменится и 
покажет, что папка назначена циклу.

Щелкните правой кнопкой мыши папку наборов тестов Cycle 2 - Full и 
выберите команду Assign to Cycle. Назначьте папку циклу Cycle 2 - Full, 
который находится в релизе Service Pack 1 в дереве релизов.
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 6 Добавьте набор тестов в папку с наборами тестов Cycle 1 - New 
Features

В дереве наборов тестов выделите Cycle 1 - New Features.

Нажмите кнопку New Test Set. Откроется диалоговое окно New Test Set.

Введите следующее:

Test Set Name: Mercury Tours Site

Description: This test set includes tests that verify the functionality of the 
Mercury Tours site.

Нажмите кнопку OK. Набор тестов Mercury Tours Site добавится к дереву 
наборов тестов в левой области.
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 7 Задайте характеристики набора тестов.

Перейдите на вкладку Details. По умолчанию в поле Status показывается, 
что набор тестов имеет статус Open. 

Установите следующие значения:

Open Date: Выберите дату планового для открытия набора тестов.

Close Date: Выберите дату планового закрытия набора тестов.
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 8 Задайте правила для автоматизированных тестов из набора тестов, 
которые должны выполняться в случае отрицательного результата. 

Перейдите на вкладку Automation. Щелкните ссылку On Failure.

Установите следующие значения: 

On automated test failure: Установите флажок в первом поле и убедитесь, 
что в числе повторного выполнения автоматизированных тестов указано 1. 

On final test failure: Убедитесь, что выбран параметр Do nothing.
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 9 Дайте Quality Center инструкции разослать сообщения по электронной 
почте указанным пользователям в случае тех или иных событий.

Щелкните ссылку Notifications. 

Установите следующие значения:

Send e-mail in the event of: Установите первый флажок, чтобы отправить 
уведомление по электронной почте в случае сбоя любого теста из набора. 

To: Введите свой адрес электронной почты.

Message: Введите следующее: 
This test failed. Please review the test results and submit a defect. 
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Добавление тестов в набор
После определения набора тестов в него можно добавлять экземпляры 
тестов. В этом упражнении вы добавите экземпляры тестов в набор тестов 
Mercury Tours Site.

Процедура добавления теста в набор тестов.

 1 Убедитесь, что модуль Test Lab открыт.

Если это не так, нажмите кнопку Test Lab на боковой панели. 

Если на экран не отображается окно Test Sets Tree, выберите View > Test 
Sets Tree.

 2 Откройте вкладку Execution Grid.

В дереве набора тестов разверните папку набора тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

Перейдите на вкладку Execution Grid.
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 3 Откройте дерево плана тестирования, если оно еще не открыто.

Нажмите кнопку Select Tests. На правой панели откроется дерево плана 
тестирования.

Если используются фильтры, сбросьте их:

В дереве плана тестирования нажмите стрелку Set Filter/Sort и выберите 
Clear Filter/Sort. Нажмите кнопку Yes для подтверждения.

На вкладке Execution Grid нажмите стрелку Set Filter/Sort и выберите Clear 
Filter/Sort. Нажмите кнопку Yes для подтверждения.

 4 Добавьте папку Cruises в дерево набора тестов.

В дереве плана тестирования выберите папку Cruises и нажмите кнопку 
Add Tests to Test Set. 
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Нажмите кнопку Yes для подтверждения. Откроется диалоговое окно 
Parameters of Test, поскольку в набор тестов добавляется тест без 
значения параметра. Чтобы закрыть диалоговое окно, нажмите кнопку 
Cancel. Этому параметру присваивается значение во время выполнения 
теста Cruise Booking (см. “Выполнение тестов вручную" на стр. 98). Тесты 
добавятся в дерево наборов тестов.

 5 Добавьте тест Airline Preference в набор.

Для поиска теста в поле Find введите airline и нажмите кнопку Find. Тест 
Airline Preference будет выделен на дереве плана тестирования.

Щелкните тест Airline Preference дважды. Тест добавится в набор тестов.

 6 Добавьте тест Number of Passengers в набор тестов.

Для поиска теста в поле Find введите Number of Passengers и нажмите 
кнопку Find. Тест Number of Passengers будет выделен на дереве плана 
тестирования.

Для добавления теста Number of Passengers в набор тестов перетащите 
его из дерева плана тестирования в таблицу Execution Grid.

 7 Закройте правую панель.

Нажмите кнопку Close. 
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Составление расписания выполнения тестов
На вкладке Execution Flow можно указать дату, время и условия 
выполнения теста. В основе условия лежат результаты выполнения 
другого теста, заданного в Execution Flow. Задавая условия, можно 
отложить выполнение теста до завершения или успешного выполнения 
другого теста. Также можно установить последовательность выполнения 
тестов. 

Например, можно запланировать выполнение теста Test 2 только после 
окончания теста Test 1, а теста Test 3 — только после успешного 
выполнения теста Test 2. Также можно установить дату выполнения тестов 
Test 1 и Test 2  за день до теста  Test 3. На вкладке Execution Flow тесты и 
их условия будут отображаться в виде диаграммы. 



Урок 5 • Выполнение тестов

90

Стрелка с пунктирной линией обозначает тест без условий. 
Сплошная линия со стрелкой обозначает условие, она может 
быть синей или зеленой. Если сплошная линия синего цвета, это означает, 
что задано условие «Finished». Если сплошная линия зеленого цвета, это 
означает, что задано условие «Passed». Рядом с тестами, зависящими от 
времени, отображается значок Time Dependency .

В ходе этого упражнения вы создадите новый набор тестов и добавите в 
него три теста, которые проверяют процедуру входа на странице Sign-On 
сайта Mercury Tours. Затем вы зададите условия для каждого теста и 
определите время их выполнения.

Чтобы составить план выполнения тестов:

 1 Убедитесь, что модуль Test Lab открыт.

Если это не так, нажмите кнопку Test Lab на боковой панели. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Создайте новый набор тестов.

В дереве набора тестов выделите папку Service Pack 1 и нажмите кнопку 
New Test Set. Откроется диалоговое окно New Test Set.

Введите следующее:

Test Set Name: Test Run Schedule
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Description: This test set is used to explain how to schedule a test run.

Нажмите кнопку OK. Набор тестов Test Run Schedule добавится в дерево 
наборов тестов в левой области. 

 3 Добавьте тест из папки Sign-On/Sign-Off к набору тестов Test Run 
Schedule.

Перейдите на вкладку Execution Grid. Если дерево плана тестирования не 
открыто, нажмите кнопку Select Tests. Дерево плана тестирования 
отобразится в правой области.

В поле Findдерева плана тестирования введите sign и нажмите кнопку Find 
для поиска папки Sign-On/Sign-Off. Папка Sign-On/Sign-Off будет 
выделена в дереве плана тестирования.

Выделите тест Sign-On Page. Нажмите кнопку Add Tests to Test Set. 
Откроется диалоговое окно Parameters of Test, поскольку в набор тестов 
добавляется тест без значения параметра. Чтобы закрыть диалоговое 
окно, нажмите кнопку Cancel. Тест добавится в набор тестов.

 4 Добавьте два дополнительных теста в набор.

Перетащите тест Sign-On User Name в область Execution Flow. Откроется 
диалоговое окно Parameters of Test. Нажмите кнопку Cancel.
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Дважды щелкните тест Sign-On Password, чтобы добавить его в область 
Execution Flow. Откроется диалоговое окно Parameters of Test. Нажмите 
кнопку Cancel.
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 5 Добавьте условие выполнения теста Sign-On User Name.

Правой кнопкой мыши щелкните тест Sign-On User Name и выберите Test 
Run Schedule. Откроется диалоговое окно Run Schedule, содержащее 
вкладку Execution Conditions. 

Нажмите New. Откроется диалоговое окно New Execution Condition.

В поле Test выделите тест <[1]Sign-On Page>.
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Из списка справа выберите Passed, чтобы настроить Quality Center на 
выполнение теста Sign-On User Name, только если тест Sign-On Page  
будет выполнен успешно.

Нажмите кнопку OK. Условие будет добавлено в диалоговое окно Run 
Schedule.
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 6 Добавьте условие зависимости теста Sign-On User Name от времени.

Перейдите на вкладку Time Dependency.

Под пунктом Run At Specified Time поставьте дату в поле Date и выберите 
завтрашнюю дату.
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Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. 
Условия появятся в схеме выполнения Execution Flow.

 7 Добавьте условие выполнения в тест Sign-On Password.

Добавьте условие выполнения, описанное в шаге 5 на странице 93 в тест 
Sign-On Password. Теперь выберите тест Sign-On User Name в поле Test 
в диалоговом окне New Execution Condition.
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 8 Добавьте условие временной зависимости в тест Sign-On Password.

Добавьте условие временной зависимости, которое описано в шаге 6 на 
странице 95 для теста Sign-On Password.

Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. 
Условия появятся в схеме выполнения Execution Flow.
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 9 Реорганизуйте тесты в иерархическую структуру.

Нажмите кнопку Arrange Layout.

Выполнение тестов вручную
При выполнении теста вручную пользователь выполняет шаги тестов и 
операции с приложением. Затем он записывает результаты и сравнивает 
их с ожидаемыми. Ручной тест можно выполнять неограниченное 
количество раз. При этом отдельно сохраняются результаты каждого 
выполнения теста. 

Вручную можно выполнять как ручные, так и автоматизированные тесты. 
Кроме того, можно выполнить один тест или весь набор тестов.

В этом упражнении вы выполните тесты Cruise Booking и Cruise Search.
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Процедура выполнения теста вручную.

 1 Убедитесь, что модуль Test Lab открыт.

Если это не так, нажмите кнопку Test Lab на боковой панели. Перейдите на 
вкладку Execution Grid. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Выделите набор тестов Mercury Tours Site.

В дереве набора тестов разверните папку с наборами тестов Cycle 1 - New 
Features под папкой  Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

 3 Выберите тест Cruise Booking в таблице Execution Grid.

На вкладке Execution Grid выберите Cruise Booking.

Нажмите кнопку Run. Откроется диалоговое окно Manual Runner.
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 4 Запустите тест.

Нажмите кнопку Begin Run. Откроется диалоговое окно Parameters of Test 
Run, поскольку тест содержит параметр без значения
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 5 Присвойте значение параметру пароля.

В поле Actual Value для параметра password введите пароль, который 
использовался для Mercury Tours. Дополнительные сведения см. в разделе 
“Пример веб-сайта Mercury Tours" на стр. 26.

Нажмите кнопку OK. Откроется диалоговое окно Manual Runner.
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 6 Откройте диалоговое окно Manual Runner в режиме Compact View. 

Нажмите кнопку Compact view. Это позволит читать каждый шаг по 
отдельности и записывать результаты.

 7 Выполните первый шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Mercury Tours site opens.

Нажмите кнопку Pass Selected. Откроется шаг 2.

 8 Выполните второй шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Flight Finder page opens.

Нажмите кнопку Pass Selected. Откроется шаг 3.
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 9 Выполните третий шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Cruise Special page opens.

Нажмите кнопку Pass Selected. Откроется шаг 4.

 10 Выполните четвертый шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат отличается от ожидаемого результата в поле 
Actual введите: The Flight Finder page opens instead of the Cruise 
Reservation page.

Нажмите кнопку Fail Selected. 

Примечание: При обнаружении дефекта приложения во время 
выполнения теста можно нажать кнопку New Defect, чтобы открыть 
диалоговое окно New Defect и добавить дефект. В этом упражнении этот 
дефект будет отправлен в “Добавление новых дефектов" на стр. 115.

 11 Вернитесь к исходному окну Manual Runner.

Нажмите кнопку Back to Steps Grid. Исходное окно Manual Runner: 
отображается диалоговое окно Step Details. 

 12 Завершите выполнение теста.

Нажмите кнопку End Run для завершения выполнения теста.

 13 Выполните тест Cruise Search.

На вкладке Execution Grid выберите тест Cruise Search и нажмите кнопку 
Run. Откроется Manual Runner.

Выполните шаги теста, как в случае с тестом Cruise Booking, но на этот 
раз выберите Pass для каждого шага.
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 14 Просмотрите результаты выполнения теста в таблице Execution Grid.

После выполнения тестов можно просмотреть результаты последнего 
выполненного теста на вкладке Execution Grid. Обратите внимание, что 
статус теста Cruise Booking обновился с No Run до Failed, а статус теста 
Cruise Search - с No Run до Passed.

 15 Просмотрите результаты каждого шага тестирования в области Last 
Run Result.

Выберите тест Cruise Booking. Если панель Last Run Result не 
отображается, нажмите кнопку Show в нижней части панели. Панель Last 
Run Result отобразится под вкладкой Execution Grid.

Щелкните каждый шаг, чтобы просмотреть его описание, а также 
ожидаемые и фактические результаты.
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Просмотр и анализ результатов тестирования
Quality Center имеет ряд функций, которые позволяют просматривать и 
анализировать результаты тестирования.

Данный раздел содержит следующие подразделы.

➤ Просмотр результатов тестирования

➤ Просмотр покрытия тестами

➤ Просмотр хода выполнения тестирования

Отчеты и диаграммы Quality Center можно использовать для дальнейшего 
анализа результатов теста. Дополнительные сведения см. в разделе 
“Создание отчетов и диаграмм" на стр. 135.

Просмотр результатов тестирования
Результаты тестирования отображаются в диалоговом окне Test Instance 
Properties. Они включают в себя сведения о выполнении теста, вложения, 
связанные дефекты и журнал внесенных изменений. 

В данном упражнении вы узнаете, как просматривать информацию о 
выполнении теста в диалоговом окне Test Instance Properties.

Просмотр результатов выполнения теста.

 1 Убедитесь, что модуль Test Lab открыт.

Если это не так, нажмите кнопку Test Lab на боковой панели. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Откройте набор тестов Mercury Tours Site на вкладке Execution Grid.

Перейдите на вкладку Execution Grid.

В дереве набора тестов разверните папку набора тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

 3 Выберите тест Cruise Booking в таблице Execution Grid.

На вкладке Execution Grid выберите Cruise Booking.
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 4 Просмотрите подробные результаты тестирования в диалоговом 
окне Test Instance Properties.

Нажмите кнопку Test Instance Properties. Откроется диалоговое окно Test 
Instance Properties с представлением All Runs.

 5 Просмотрите другую информацию о результатах тестирования в 
диалоговом окне Test Instance Properties.

Чтобы просмотреть подробные сведения о выполнении теста нажмите 
Details.

Нажмите Configuration и выберите вкладку Manual Parameters для 
просмотра ручных параметров теста. Обратите внимание, что все 
вносимые изменения будут задействованы во время следующего 
выполнения теста.

Для просмотра связей дефектов с объектами Quality Center и управления 
ими, нажмите Linked Defects.
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Чтобы просмотреть список изменений внесенных в поля выполнения теста, 
нажмите History.

 6 Закройте диалоговое окно Test Instance Properties.

Нажмите кнопку Close.

Просмотр покрытия тестами
Ранее вы узнали, как использовать окно Coverage Analysis для анализа 
распределения дочерних требований в соответствии с покрытием тестами 
(см. раздел “Анализ покрытия тестами" на стр. 70). 

В этом упражнении вы узнаете, как фильтровать по циклу тесты, 
включенные в анализ покрытия.

Quality Center Starter Edition: Данный урок невозможно выполнить с 
помощью Quality Center Starter Edition.

Просмотра покрытия тестами.

 1 Откройте модуль Requirements в представлении Coverage Analysis.

Нажмите кнопку Requirements на боковой панели.

Выберите View > Coverage Analysis.

 2 Отфильтруйте по циклу тесты, входящие в анализ покрытия.

В верхнем правом углу окна нажмите кнопку обзора в поле Coverage 
calculation by cycle.

В дереве релизов разверните папку релизов Service Packs и релиз Service 
Pack 1. Установите флажок Cycle 1 - New Features и нажмите OK.
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Разверните требование Cruise Reservation. В столбце Coverage Analysis 
видно, что при тестировании обоих требований нижнего уровня произошел 
сбой. Это вызвано неудачным результатом тестов, которые выполнялись в 
соответствии с этим требованием.

Просмотр хода выполнения тестирования
Ранее вы познакомились с функциями вкладки Progress модуля Releases 
(см. раздел “Просмотр релизов и циклов" на стр. 34). В данном упражнении 
вы увидите, как диаграммы и статистика отражают результаты тестов, 
которые были выполнены в предыдущих упражнениях.

Quality Center Starter Edition: Данный урок невозможно выполнить с 
помощью Quality Center Starter Edition.
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Просмотра хода выполнения тестирования.

 1 Откройте модуль Releases.

Нажмите кнопку Management на боковой панели и откройте вкладку 
Releases.

 2 Просмотрите результаты выполнения тестов на вкладке Progress.

В дереве релизов разверните папку релизов Service Packs и релиз Service 
Pack 1. Выберите Cycle 1 - New Features  и откройте вкладку Progress.
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В верхней области показано общее количество дней и количество дней до 
завершения цикла; общее количество экземпляров тестов в цикле, 
количество выполненных и невыполнявшихся экземпляров тестов и многое 
другое. 

В нижней области приведена диаграмма хода выполнения тестирования. 
Planned coverage показывает количество тестов, запланированных для 
выполнения в каждый из дней цикла. Executed coverage означает 
количество тестов (в процентах), которые выполнялись каждый из дней 
цикла. Passed coverage означает количество тестов (в процентах), 
которые успешно выполнялись  каждый из дней цикла.

Автоматическое выполнение тестов
Если выполняется автоматизированный тест, Quality Center автоматически 
открывает выбранное средство тестирования, запускает тест на локальном 
компьютере или на удаленном хосте, а затем импортирует результаты 
тестирования в Quality Center. 

Можно выполнять все тесты из набора тестов или только выбранные 
тесты. Выполнять можно тесты, выбранные на вкладке Execution Grid или 
на вкладке Execution Flow. 

В этом упражнении вы выполните автоматизированный тест из набора 
тестов Mercury Tours Site.

Процедура выполнения автоматизированного теста.

 1 Убедитесь, что модуль Test Lab открыт.

Если это не так, нажмите кнопку Test Lab на боковой панели. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Откройте набор тестов Mercury Tours Site на вкладке Execution Grid.

Перейдите на вкладку Execution Grid.

В дереве набора тестов разверните папку набора тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 
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 3 Выберите тест.

Для выполнения теста WinRunner выберите Airline Preference. 

Для выполнения теста QuickTest Professional выберите Number of 
Passengers.

Нажмите кнопку Run. Откроется диалоговое окно Automatic Runner, в 
котором будет отображаться выбранный тест.

 4 Задайте параметры выполнения теста.

Установите флажок Run All Tests Locally для выполнения теста на 
локальном компьютере.
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 5 Выполните тест.

Нажмите кнопку Run. Quality Center автоматически откроет выбранное 
средство тестирование и выполнит тест. Ход выполнения теста 
отображается в столбце Status.

 6 Закройте диалоговое окно Automatic Runner.

После завершения выполнения теста выберите Run >Exit.

 7 Просмотрите сводку результатов выполнения теста на вкладке 
Execution Grid. 

На вкладке Execution Grid отображается обновленный статус выполнения 
теста. Результаты каждого шага теста отображаются в области Last Run 
Result.

 8 Закройте выбранное средство тестирования.

В приложении QuickTest Professional или WinRunner выберите File >Exit.
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6
Добавление и отслеживание дефектов

Важной частью процесса разработки является выявление и устранение 
дефектов в приложениях. Пользователи могут находить дефекты и 
сообщать о них на всех этапах процесса управления жизненным циклом 
приложения. С помощью Quality Center можно регистрировать дефекты, 
обнаруженные в приложении, и отслеживать их до устранения и 
повторного тестирования.

Во время этого урока вы узнаете следующее.

 ➤  Отслеживание дефектов на стр. 114

 ➤  Добавление новых дефектов на стр. 115

 ➤  Сопоставление дефектов на стр. 118

 ➤  Обновление дефектов на стр. 119

 ➤  Связывание дефектов с тестами на стр. 123

 ➤  Создание избранного представления. на стр. 125



Урок 6 • Добавление и отслеживание дефектов

114

Отслеживание дефектов
Отслеживание дефекта, зарегистрированного в проекте Quality Center,  
включает следующие этапы. New, Open, Fixed и Closed. После устранения 
дефекту может быть присвоен статус Rejected или Reopened .

При первоначальной регистрации в Quality Center дефекту присваивается 
статус New (по умолчанию). Менеджер по контролю качества или 
руководитель проекта изучает дефект и определяет, следует ли его 
устранять.  Если дефект отклоняется, ему присваивается статус Rejected. 
Если дефект необходимо устранить, менеджер по контролю качества или 
руководитель проекта определяет приоритеты устранения, изменяет 
статус дефекта на Open и передает его участнику группы разработчиков 
приложения. Разработчик устраняет дефект и присваивает ему статус 
Fixed. Пользователь повторно тестирует приложение, проверяя отсутствие 
дефекта.

Если дефект возникает повторно, менеджер по контролю качества или 
руководитель проекта присваивает ему статус Reopened. Если дефект 
устранен, менеджер по контролю качества или руководитель проекта 
присваивает ему статус Closed.
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Добавление новых дефектов
Добавить новый дефект в проект Quality Center можно на любом этапе 
процесса управления жизненным циклом приложения. В этом упражнении 
вы добавите дефект, обнаруженный при выполнении теста Cruise 
Booking.

Для добавления нового дефекта выполните следующие действия.

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Defects.

Нажмите кнопку Defects на боковой панели. На вкладке Defects Grid 
отображаются данные о дефектах в виде таблицы. В каждой строке этой 
таблицы отображаются данные по конкретному дефекту.
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 3 Откройте диалоговое окно New Defect.

Нажмите кнопку New Defect. Откроется диалоговое окно New Defect.

 4 Введите описание дефекта.

Установите следующие значения:

Summary: Unable to reserve a cruise from the Cruise page. 

Category: Defect

Severity: 2-Medium 

Subject: Cruises 

Description:  The defect was detected in the Cruise Booking test. When you 
click the Now Accepting Reservations button, the Flight Finder page opens 
instead of the Cruise Reservation page.
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 5 Определите цикл, в котором был обнаружен дефект.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 6.

В поле Detected in Cycle нажмите кнопку обзора. Откроется дерево 
релизов. Разверните дерево. В папке релизов Service Packs релизе 
Service Pack 1 выделите цикл Cycle 1 - New Features. 

Видно, что Quality Center автоматически присваивает значение Service 
Pack 1 полю Detected in Release. Это происходит, потому что цикл Cycle 1 
- New Features является частью релиза Service Pack 1.

Чтобы закрыть дерево релизов, нажмите кнопку OK.

 6 Добавьте URL-адрес страницы Mercury Tours, на которой обнаружен 
дефект.

Нажмите кнопку Attach URL. Откроется диалоговое окно Attach Uniform 
Resource Locator (URL). 

Введите URL-адрес страницы Mercury Tours. 
http://<Quality Center имя сервера>/mtours

Нажмите кнопку OK. URL-адрес будет отображаться над полем 
Description.

 7 Добавьте дефект в проект Quality Center.

Нажмите кнопку Submit. Дефект добавится в таблицу Defects Grid.

 8 Закройте диалоговое окно New Defect.

Нажмите кнопку Close.
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Сопоставление дефектов
Сопоставление дефектов позволяет устранять дублированные или схожие 
дефекты в проекте. При каждом добавлении нового дефекта Quality Center 
сохраняет списки ключевых слов из полей Summary и Description. При 
поиске аналогичных дефектов ключевые слова из этих полей 
сопоставляются с другими дефектами. Обратите внимание, что ключевые 
слова должны содержать больше двух символов, и регистр букв не влияет 
на результаты.

В этом упражнении вы сопоставите дефекты путем сравнения выбранного 
дефекта с остальными дефектами проекта QualityCenter_Demo.

Порядок сопоставления дефектов.

 1 Убедитесь, что открыт модуль Defects.

Если это не так, нажмите кнопку Defects на боковой панели. 

 2 Выберите Defect ID 37.

Если к таблице были применены фильтры, нажмите стрелку Set Filter/Sort 
и выберите Clear Filter/Sort для сброса фильтра.

В таблице Defects Grid выберите Defect ID 37. 

 3 Найдите аналогичные дефекты.

Нажмите кнопку Find Similar Defects .
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Результаты сохраняются в диалоговом окне Similar Defects, упорядоченные 
в соответствии со сходством (в процентах). Обратите внимание, что в 
проекте для нет дубликатов выбранного дефекта.

Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.

Обновление дефектов
Отслеживание устранения дефектов в проекте требует периодического 
обновления дефектов. Данную операцию можно выполнить напрямую в 
таблице Defects Grid или в диалоговом окне Defect Details. Возможность 
обновления полей некоторых дефектов зависит от параметров доступа. 
После обновления дефектов можно просмотреть текущий статус качества 
релиза в модуле Release.

В этом упражнении вы измените информацию о дефекте,  изменив уровень 
серьезности дефекта, назначив дефект в цикл и добавив комментарий. 
Затем вы увидите влияние обновлений дефектов на вкладке Quality модуля 
Releases.
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Quality Center Starter Edition: Поля и команды, относящиеся к циклам и 
релизам, недоступны в Quality Center Starter Edition.

Для обновления дефектов выполните следующие действия.

 1 Убедитесь, что открыт модуль Defects.

Если это не так, нажмите кнопку Defects на боковой панели. 

 2 Откройте диалоговое окно Defect Details.

В таблице Defects выберите дефект, добавленный в разделе “Добавление 
новых дефектов" на стр. 115. Нажмите кнопку Defect Details. Откроется 
диалоговое окно Defect Details. 

 3 Измените уровень серьезности дефекта.

В поле Severity выберите 5-Urgent.
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 4 Определите цикл, в котором будет устранен дефект.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, перейдите к шагу 5.

В поле Target Cycle нажмите кнопку обзора. Откроется дерево релизов. 
Разверните дерево. В папке релизов Service Packs в релизе Service Pack 
1 выделите цикл Cycle 2 - New Features. 

Мы видим, что Quality Center автоматически присваивает значение Service 
Pack 1 полю Target Release. Это происходит, потому что цикл Cycle 2 - Full 
является частью релиза Service Pack 1.

Чтобы закрыть дерево релизов, нажмите кнопку OK.

 5 Добавьте комментарий, чтобы объяснить изменения в уровне 
серьезности дефекта.

Нажмите кнопку Add Comment. Новый раздел будет добавлен в поле 
Comments с именем пользователя и текущей датой.

Введите: This defect should be fixed in the next service pack.

 6 Просмотрите вложения.

Нажмите кнопку Attachments на боковой панели. Обратите внимание, что 
отображается вложенный URL-адрес.

 7 Просмотрите связанные объекты.

Щелкните Linked Entities на боковой панели, чтобы просмотреть объекты, 
связанные с дефектом. Связанными объектами могут быть требования, 
тесты, наборы тестов, экземпляры тестов, выполнения тестов, шаги 
выполнения и другие дефекты. На данный момент связанные объекты 
отсутствуют. Вы научитесь связывать дефект с тестом в разделе 
“Связывание дефектов с тестами" на стр. 123.

 8 Просмотрите журнал внесенных изменений.

Щелкните History на боковой панели, чтобы просмотреть историю 
изменений, внесенных в дефект. Для каждого изменения в таблице 
отображается дата и время, а также имя пользователя, который внес 
изменение. Можно развернуть изменение, чтобы просмотреть список 
измененных полей. Для каждого поля в таблице отображаются старое и 
новое значения.
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 9 Закройте диалоговое окно Defect Details.

Нажмите кнопку OK, чтобы закрыть диалоговое окно.

 10 Обновите дефекты непосредственно в таблице Defects Grid.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, пропустите этот шаг.

В таблице Defects Grid выберите Defect  ID 23. 

В поле Detected in Cycle нажмите стрелку раскрывающегося списка. В 
дереве релизов разверните папку релизов Service Packs и релиз Service 
Pack 1. Выберите цикл Cycle 1 - New Features и нажмите кнопку OK.

Щелкните поле Target Cycle и нажмите кнопку обзора. В дереве релизов 
разверните папку релизов Service Packs и релиз Service Pack 1. Выберите 
Cycle 1 - New Features и нажмите кнопку OK.

 11 Обновите дефекты 35 и 36.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, пропустите этот шаг.

Повторите шаг 10 для дефектов 35 и 36.

 12 Посмотрите число дефектов, открытых в цикле Cycle 1 - New Features 
на вкладке Quality.

Quality Center Starter Edition: Если вы используете Quality Center Starter 
Edition, пропустите этот шаг.

Нажмите кнопку Management на боковой панели. Во вкладке Releases 
разверните папку релизов Service Packs и релиз Service Pack 1 и 
выделите цикл Cycle 1 - New Features. Перейдите на вкладку Quality.

На диаграмме Defect Opening Rate  приводятся дефекты, обнаруженные в 
цикле Cycle 1 - New Features в соответствии с уровнем их серьезности.

На диаграмме Outstanding Defects  приводятся неустраненные дефекты 
цикла Cycle 1 - New Features в соответствии с уровнем их серьезности. 
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Связывание дефектов с тестами
В плане тестирования вы можете связать тест с конкретным дефектом из 
таблицы Defects Grid. Это полезно, например, при создании нового теста 
специально для отслеживания того или иного дефекта. Создав такую 
связь, можно задать выполнение теста в зависимости от статуса дефекта. 
Обратите внимание, что дефекты также можно связать с другими 
объектами, такими как требования.

Дефекты могут быть связаны с объектами напрямую или косвенно. При 
добавлении связи дефекта с объектом Quality Center добавляет прямую 
связь с самим объектом и косвенные связи с другими сопутствующими 
объектами. 

На приведенной ниже схеме показан процесс косвенного связывания:

Например, при связывании дефекта с шагом выполнения добавляется 
косвенная связь с выполнением, экземпляром теста, набором тестов и 
тестом. Если этот тест покрывается требованием, также добавляется 
косвенная связь с требованием. Учтите, что косвенное связывание 
представляет собой односторонний процесс. Например, при связывании 
дефекта с выполнением косвенная связь дефекта с шагами выполнения не 
создается.

В этом упражнении вы свяжете дефект с тестом Cruise Booking модуля 
Test Plan и посмотрите связанные тесты в таблице Defects Grid.

Порядок связывания дефекта с тестом.

 1 Откройте модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

 2 Выберите тест Cruise Booking.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Booking. Перейдите на вкладку 
Linked Defects.
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 3 Добавьте связанный дефект.

На вкладке Linked Defects нажмите стрелку Link Existing Defect и 
выберите Select. Откроется диалоговое окно Defects to Link. 

Выберите дефект, добавленный в “Добавление новых дефектов" на 
стр. 115 и нажмите кнопку Link. Дефект добавится в таблицу Linked 
Defects.

Примечание. Если дефект не отображается в диалоговом окне Defects to 
Link, нажмите стрелку Set Filter/Sort и выберите команду Clear Filter/Sort, 
чтобы сбросить фильтр, примененный к таблице.
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 4 Просмотрите связанный тест в таблице Defects Grid.

Нажмите кнопку Defects на боковой панели.

Щелкните дважды дефект в таблице Defects Grid. Откроется диалоговое 
окно Defect Details.

Нажмите Linked Entities на боковой панели и перейдите на вкладку 
Others. Тест Cruise Booking связан с дефектом.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Defect Details.

Создание избранного представления.
Избранные представления — это окна Quality Center, к которым 
применены пользовательские параметры.. Например, в таблице Defects 
Grid можно применить фильтр для отображения только дефектов, которые 
были обнаружены вами, назначены вам или имеют статус «Not Closed». 

В этом упражнении вы создадите избранное представление в таблице 
Defects Grid.

Порядок создания избранного представления.

 1 Убедитесь, что открыт модуль Defects.

Если это не так, нажмите кнопку Defects на боковой панели. 
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 2 Настройте фильтр для просмотра обнаруженных вами дефектов, 
которые еще не закрыты.

Нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 
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В поле Detected By нажмите Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition.

В столбце Name выберите свое имя пользователя для входа в 
Quality Center (alice_qc, cecil_qc или michael_qc). Нажмите кнопку OK, 
чтобы закрыть диалоговое окно Select Filter Condition.

Для поля Status нажмите поле Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition.

На правой панели щелкните логическое выражение Not.

На левой панели выберите Closed.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы применить выбранный фильтр.

В таблице Defects Grid отобразятся обнаруженные вами дефекты, которые 
еще не закрыты.
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 3 Добавьте избранное представление.

В меню Favorites выберите Add to Favorites. Откроется диалоговое окно 
Add Favorite.

В поле Name введите:  My detected defects (status ‘Not Closed’).

Избранное представление можно добавить в общую или личную папку. 
Представления в общей папке доступны всем пользователям. Доступ к 
представлениям в личной папке имеют только их создатели. Выберите 
Private. 

Нажмите кнопку OK. Новое представление добавлено в вашу личную 
папку.
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7
Оповещение об изменениях

Можно настроить Quality Center на автоматическое создание оповещений и 
отправки сообщений по электронной почте для уведомления 
ответственных сотрудников об изменениях в проекте, способных оказать 
негативное влияние на процесс управления жизненным циклом 
приложения. Кроме того, пользователь может добавлять собственные 
напоминания об исполнении.

Для создания автоматических уведомлений администратор проекта 
Quality Center должен активировать правила оповещений в модуле Project 
Customization. Правила оповещений основываются на связях, которые 
создаются в Quality Center между требованиями, тестами и дефектами. При 
изменении объекта в проекте Quality Center оповещает все связанные 
объекты, на которые может оказать воздействие это изменение. 
Оповещения доступны для просмотра всеми пользователями. 
Quality Center также уведомляет сотрудников, ответственных за те или 
иные объекты, при внесении изменений в любые связанные объекты, на 
которые могут повлиять такие изменения.

Quality Center также позволяет добавлять пользовательские отметки к 
исполнению к требованиям, тестам, экземплярам теста или дефектам для 
напоминания о необходимости в отслеживании результата. При 
наступлении даты оповещения Quality Center отправит электронное 
сообщение с напоминанием.

Во время этого урока вы узнаете следующее.

 ➤  Активация оповещения на стр. 130

 ➤  Создание напоминаний об исполнении на стр. 132
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Активация оповещения 
При изменении теста, экземпляра теста или дефекта в проекте 
Quality Center может отправлять уведомления сотрудникам, ответственным 
за связанные с ним объекты. Тесты можно связать с требованиями (см. 
раздел “Сведения о создании и просмотре требований" на стр. 65), а 
дефекты — с другими объектами Quality Center (см. раздел “Связывание 
дефектов с тестами" на стр. 123). Кроме того, можно создавать связи 
прослеживаемости для требований  Дополнительные сведения о создании 
связей прослеживаемости между требованиями см. в документе 
Руководство по установке HP Quality Center.

Quality Center может создавать оповещения при следующих изменениях.:

В этом упражнении вы запустите функцию оповещения для тестов, 
изменив связанное требование. Вы измените требование Cruise Booking, 
а затем просмотрите отмеченные тесты.

Для запуска оповещения:

 1 Откройте дерево требований.

Нажмите кнопку Requirements на боковой панели и выберите View > 
Requirement Details.

 2 Выберите требование, которое нужно изменить.

Под требованием Cruise Reservation выделите требование Cruise 
Booking. 

Что изменилось? Какие связанные 
объекты отмечены? Кого уведомили?

Требование (исключая 
изменение статуса)

Тесты. Разработчики тестов.

Требования. Авторы требований.

Статус дефекта изменен 
на Fixed

Экземпляры теста. Ответственные 
тестировщики.

Тест выполнен успешно Дефекты. Пользователи, 
сообщившие о 
дефектах.
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 3 Просмотрите связанные тесты.

Для просмотра тестов, на которые окажет воздействие изменение, 
нажмите вкладку Test Coverage. На вкладке будут отображены связанные 
тесты.

 4 Измените приоритет требования Cruise Booking.

Перейдите на вкладку Details.

Нажмите стрелку «Вниз» в поле Priority и выберите 5-Urgent.

Это изменение заставит Quality Center создать оповещения для тестов, 
связанных с этим требованием. Кроме того, Quality Center проинформирует 
проектировщиков этих тестов по электронной почте. 

 5 Просмотрите оповещение для теста Cruise Booking.

На вкладке Test Coverage  нажмите тест Cruise Booking. Тест будет 
выделен в дереве плана тестирования.

Нажмите кнопку Refresh All.

У теста Cruise Booking поставлен предупреждающий флажок , 
показывающий, что изменение внесено в связанное требование. 

Щелкните флажок Alerts для теста Cruise Booking. Откроется диалоговое 
окно Alerts. 
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Оповещение содержит требование и изменение, которое спровоцировало 
оповещение . Кроме того, оно содержит имя сотрудника, который получит 
уведомление от Quality Center о данном изменении по электронной почте. 

Нажмите кнопку Close.

 6 Просмотрите оповещения для других связанных тестов.

Просмотрите оповещения следующих тестов в дереве плана тестирования. 
Cruise Search, Cancel All Reservations  и Airline Preference.

Создание напоминаний об исполнении
Quality Center позволяет добавлять пользовательские оповещения, чтобы 
напомнить о необходимости решения проблем. В этом упражнении вы 
добавите отметку исполнения к дефекту, статус которого следует 
проверить через неделю после сегодняшней даты.

При добавлении отметки исполнения  Quality Center добавляет 
информационную панель, напоминающую о необходимости оповещения . 
При наступлении даты оповещения Quality Center отправит электронное 
сообщение с напоминанием об этом и изменит цвет флажка с серого на 
красный.

Обратите внимание, что отметки исполнения связаны с конкретным 
пользователем, и это означает, что только их автор может просматривать 
напоминания об исполнении.

Чтобы создать напоминание об исполнении:

 1 Откройте модуль Defects.

Нажмите кнопку Defects на боковой панели.

 2 Выберите дефект, для которого вы хотите ввести напоминание об 
исполнении.

В таблице Defects Grid выберите дефект.
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 3 Создайте напоминание об исполнении.

Нажмите кнопку  Flag for Follow Up. Откроется диалоговое окно Flag for 
Follow Up. 

Установите следующие значения:

Follow up by: Выберите дату через неделю от сегодняшней даты.

Description: Введите: Remind me about this defect on this date.

Нажмите кнопку OK. Флажок  будет добавлен к сведениям о дефекте.
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 4 Откройте информационную панель для напоминания об исполнении.

Дважды щелкните дефект с отметкой исполнения. Откроется диалоговое 
окно Defect Details и отобразится информационная панель с напоминанием 
об исполнении.

Чтобы закрыть диалоговое окно, нажмите кнопку Cancel.

Напоминание 
об исполнении
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8
Создание отчетов и диаграмм

Отчеты и диаграммы, создаваемые в Quality Center, помогают оценить 
процесс управления жизненным циклом приложения. Пользователь может 
создавать отчеты и диаграммы в любое время. 

Отчеты и диаграммы можно создавать в модуле Dashboard или во время 
работы с модулями Requirements, Test Plan, Test Lab или Defects. В любом 
случае отчеты и диаграммы можно сохранить в модуле Dashboard для 
дальнейшего использования.

С помощью модуля Dashboard можно также создавать панели отчетов, в 
которых несколько диаграмм отображаются в один ряд. 

Во время этого урока вы узнаете следующее.

 ➤  Создание отчетов на стр. 136

 ➤  Создание диаграмм на стр. 144

 ➤  Создание панелей отчетов на стр. 151
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Создание отчетов
Отчеты можно создавать в модуле Dashboard, в котором отображаются 
данные модулей Requirements, Test Plan, Test Lab и Defects. Кроме того, 
можно создавать быстрые отчеты непосредственно из модулей 
Requirements, Test Plan, Test Lab и Defects. 

Данный раздел содержит следующие подразделы.

➤ Создание отчетов в модуле Dashboard

➤ Создание быстрых отчетов

Создание отчетов в модуле Dashboard 
В модуле Dashboard можно создавать отчеты и выбирать данные для 
включения в отчет.

Отчеты сохраняются в папке public или в папке private. Отчеты из папки 
public доступны всем пользователям. Отчеты из папки private доступны 
только пользователям, создавшим их.

В этом упражнении вы создадите и настроите параметры отчета с 
помощью модуля Dashboard.

Чтобы создать отчет в модуле Dashboard:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в него. 
Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Requirements.

Нажмите кнопку Dashboard на боковой панели, чтобы открыть модуль 
Dashboard. 

Если вкладка Analysis View не была открыта автоматически, нажмите на 
вкладку Analysis View.
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 3 Добавьте папку в корневой каталог Private.

В дереве выберите папку Private. 

Нажмите кнопку New Folder. Откроется диалоговое окно New Folder.

В поле Folder Name введите Requirements. 

Нажмите кнопку OK. Новая папка будет вложена в каталог Private. На 
вкладке Details отображаются название папки и имя пользователя, 
создавшего ее. 

В поле Description введите This folder includes requirement reports.

 4 Создайте отчет.

Нажмите кнопку New Item и выберите New Standard Report. Откроется 
диалоговое окно New Standard Report.

Выберите Requirements в поле Entity.

В поле Standard Report Name введите Requirement report.

Нажмите кнопку OK. Отчет будет добавлен в папку private.

 5 Добавьте описание отчета.

Перейдите на вкладку Details. 

В поле Description введите This is my private requirement report.
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 6 Откройте параметры.

Перейдите на вкладку Configuration. 

На этой вкладке можно настроить внешний вид и содержимое отчетов 
Quality Center. 

 7 Задайте количество элементов, которые должны отображаться на 
странице.

В блоке Page выберите All items in one page, чтобы отобразить все 
элементы на одной странице.
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 8 Задайте фильтр для просмотра требований, созданных конкретным 
пользователем.

В блоке Filter нажмите кнопку Set Filter/Sort . Откроется диалоговое окно 
Filter. 

Щелкните параметр Filter Condition для поля Author. Нажмите кнопку 
обзора. Откроется диалоговое окно Select Filter Condition.

В столбце Name выберите свое имя пользователя для входа в 
Quality Center (alice_qc, cecil_qc или michael_qc). Нажмите кнопку OK, 
чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.

 9 Отображение отчета в виде таблицы.

В блоке Options выберите Grid View.
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 10 Создайте отчет.

Перейдите на вкладку View для создания отчета с обновленными 
параметрами.

В этом отчете приводятся требования, которые включены в текущее 
представление требований выбранного автора.
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Создание быстрых отчетов
Экспресс-отчеты представляют собой отчеты, отображающие данные 
модулей Requirements, Test Plan, Test Lab и Defects. При создании быстрых 
отчетов можно воспользоваться списком готовых отчетов или создать 
отчеты для немедленного отображения информации по выбранным 
элементам. 

Экспресс-отчеты можно использовать для однократного анализа; их также 
можно сохранять в модуле Dashboard, чтобы завершить настройку данных 
и представления.

В этом упражнении вы создадите стандартный отчет в модуле 
Requirements и сохраните его в модуле Dashboard.

Чтобы создать быстрый отчет:

 1 Откройте модуль Requirements.

Нажмите кнопку Requirements на боковой панели, чтобы открыть модуль 
Requirements. 

Если дерево требований не отображается, выберите View > Requirements 
Tree.
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 2 Создайте отчет.

Выберите Analysis > Reports > Standard Requirement Report. Откроется 
диалоговое окно Standard Requirement Report.

В этом отчете приводятся требования, которые включены в текущее 
представление требований.
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 3 Сохраните отчет в модуле Dashboard.

Нажмите кнопку Save. Откроется диалоговое окно New Standard Report.

В разделе Select Folder выберите Private. Нажмите кнопку Save.

Откроется представление Analysis View модуля Dashboard; отчет будет 
показан на вкладке View.
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Создание диаграмм
В модуле Dashboard можно создавать диаграммы, отображающие данные 
модулей Requirements, Test Plan, Test Lab и Defects. Кроме того, можно 
создавать диаграммы непосредственно из модулей Requirements, Test 
Plan, Test Lab и Defects. В любом случае диаграммы можно создавать с 
помощью мастера диаграмм, который проведет пользователя через этапы 
создания диаграммы.

Данный раздел содержит следующие подразделы.

➤ Создание диаграмм в модуле Dashboard

➤ Создание быстрых диаграмм

Создание диаграмм в модуле Dashboard 
В модуле Dashboard можно создавать диаграммы и настраивать их в 
соответствии с конкретными требованиями. Кроме того, диаграммы можно 
создавать с помощью мастера диаграмм. Этот мастер предоставляет 
пошаговые инструкции по созданию диаграммы и указанию ее параметров.

Диаграммы можно сохранять в папке public или в папке private. Диаграммы 
из папки public доступны всем пользователям. Диаграммы из папки private 
доступны только пользователям, создавшим их.

В этом упражнении вы воспользуетесь мастером диаграмм и создадите 
диаграмму дефектов со сводкой по статусу и приоритету. 

Для создания диаграммы в модуле Dashboard:

 1 Убедитесь, что модуль Dashboard открыт.

Если это не так, нажмите кнопку Dashboard на боковой панели для 
открытия модуля. 

Если вкладка Analysis View не открылась, перейдите на вкладку Analysis 
View.
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 2 Запустите мастер диаграмм.

Нажмите кнопку New Item и выберите Graph Wizard. Мастер диаграмм 
откроет диалоговое окно Select Graph Type.

 3 Выберите тип диаграммы.

Выберите Defects в поле Entity.

В группе Graph Type выберите переключатель Summary. 

Нажмите кнопку Next. Откроется диалоговое окно Select Filter.



Урок 8 • Создание отчетов и диаграмм

146

 4 Задайте фильтр для просмотра дефектов, имеющих уровни 
приоритетов от high  до urgent.

В группе Filter Selection выберите переключатель Define a new filter. 
Нажмите кнопку Filter. Откроется диалоговое окно Filter. 

Щелкните параметр Filter Condition для поля Priority . Нажмите кнопку 
обзора. Откроется диалоговое окно Select Filter Condition. 

На правой панели выберите логическое выражение >=.

На левой панели выберите 3-High.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

 5 Задайте фильтр для просмотра еще не закрытых дефектов.

Щелкните параметр Filter Condition для поля Status. Нажмите кнопку 
обзора. Откроется диалоговое окно Select Filter Condition.

На правой панели щелкните логическое выражение Not.

На левой панели выберите Closed. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.
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Нажмите кнопку Next. Откроется диалоговое окно Select Graph Attributes. 

 6 Установите параметры диаграммы.

Убедитесь, что в списке Group By field выбрано значение None. 

В списке X-axis field выберите значение Priority для отображения 
дефектов в соответствии с приоритетом.

Нажмите кнопку Next. Откроется диалоговое окно Select Name and Folder. 
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 7 Задайте имя диаграммы и ее расположение в дереве анализа.

В поле Graph Name будет указано имя по умолчанию.

Убедитесь, что в блоке Destination Folder выбрана папка Private.

 8 Создайте диаграмму.

Нажмите кнопку Finish. Диаграмма появится на вкладке View.

В диаграмме приводится сводная информация по открытым дефектам со 
статусом от high (высокий) до urgent (безотлагательный).
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 9 Откройте дополнительные сведения о дефекте.

Нажмите столбец на диаграмме. Откроется диалоговое окно Drill Down 
Results, в котором отображаются дефекты, относящиеся к данному 
столбцу. 

Закройте диалоговое окно Drill Down Results.

 10 Откройте другие представления диаграммы.

Нажмите кнопку Pie Chart для перехода к представлению круговой 
диаграммы.

Перейдите на вкладку Data Grid для отображения данных в виде таблицы.

Создание быстрых диаграмм
Экспресс-диаграммы можно создавать во время работы в модулях 
Requirements, Test Plan, Test Lab и Defects. Быстрые диаграммы позволяют 
создавать диаграммы различных типов в каждом модуле с помощью 
существующего фильтра модуля. Экспресс-диаграммы можно 
использовать для однократного анализа; их также можно сохранять в 
модуле Dashboard, чтобы завершить настройку данных и представления. 

В этом упражнении вы создадите сводную диаграмму в модуле Defects.

Чтобы создать быструю диаграмму:

 1 Откройте модуль Defects.

Нажмите кнопку Defects на боковой панели и откройте модуль Defects. 
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 2 Создайте отчет.

Выберите Analysis > Graphs > Defects Summary Group by Status. 
Откроется диалоговое окно Defects Summary - Group by Status.

Диаграмма показывает количество дефектов в проекте по с сотрудникам, 
которым они назначены. Дефекты в столбцах диаграммы сгруппированы в 
соответствии со статусом. 

 3 Закройте диалоговое окно Defects Summary - Group by Status.

Нажмите кнопку Cancel.
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Создание панелей отчетов
С помощью модуля Dashboard можно расположить и просмотреть 
несколько диаграмм в одной панели отчетов. Диаграммы для панелей 
отчетов выбираются в дереве анализа. Можно также изменять 
расположение и размер диаграмм на странице панели. 

Панели отчетов можно сохранять в папке public или в папке private. Панели 
отчетов из папки public доступны всем пользователям. Панели отчетов из 
папки private доступны только пользователям, создавшим их.

В этом упражнении вы создадите панель отчетов для отображения 
диаграмм дефектов в папке public. 

Примечание: Пользователь, под именем котором вы вошли в 
Quality Center, не имеет необходимых прав для создания панелей отчетов. 
Для выполнения этого упражнения необходимо будет войти в систему под 
другим именем.

Чтобы создать панель отчетов:

 1 Выйдите из системы и войдите заново под другим именем.

Нажмите кнопку Logout в правом верхнем углу окна. Откроется окно входа 
в HP Quality Center.

В поле Login Name введите alex_qc.

Пропустите поле Password. Этому пользователю не присвоен пароль.

Нажмите кнопку Authenticate. Quality Center проверит имя пользователя и 
пароль и определит, к каким доменам и проектам вы имеете право доступа. 

В списке Domain выберите Default.

В списке Project выберите QualityCenter_Demo.

Нажмите кнопку Login. Откроется главное окно Quality Center и 
отобразится модуль, в котором вы работали в прошлый раз.
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 2 Убедитесь, что модуль Dashboard открыт.

Если это не так, нажмите кнопку Dashboard на боковой панели для 
открытия модуля. 

Перейдите на вкладку Dashboard View.

 3 Добавьте панель в папку Public.

В дереве выберите папку Public.

Нажмите кнопку New Page. Откроется диалоговое окно New Dashboard 
Page.

В поле Dashboard Page Name введите Summary of Defects page. 

Нажмите кнопку OK. Панель отчетов будет добавлена в дерево панелей, 
вложенное в папку Public.

 4 Выберите диаграммы, которые вы хотите включить в панель отчетов.

Перейдите на вкладку Configuration. 

В области Graphs Tree раскройте папку Public.

Разверните папку Defects. В папке находятся четыре диаграммы.

Дважды щелкните первую диаграмму. Элемент панели отчетов с именем 
диаграммы будет создан на вкладке Configuration.
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Добавьте оставшиеся три диаграммы в панель отчетов.
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 5 Измените панель отчетов.

Выберите второй элемент панели отчетов и переместите его вверх так, 
чтобы он был расположен рядом с первым элементом.

Выберите четвертый элемент панели отчетов и переместите его вверх так, 
чтобы он был расположен рядом с третьим элементом.
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 6 Откройте панель отчетов.

Перейдите на вкладку View. Quality Center создаст и откроет диаграммы на 
вкладке View.

На панели отчетов показаны открытые дефекты по циклу, сотрудникам, 
уровню серьезности и объекту.

Для просмотра панели отчетов в полноэкранном режиме нажмите кнопку 
View Page in Full Screen в правом верхнем углу страницы.

Для возвращения к стандартному представлению нажмите кнопку close в 
правом верхнем углу страницы.
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9
Создание библиотек и базовых состояний

Для создания библиотек используется модуль Libraries. После создания 
библиотеки вы сможете создавать и сравнивать базовые состояния 
библиотеки для отслеживания изменений проекта.

Библиотека — набор объектов в проекте и отношений между ними. 
Объекты в библиотеке могут включать требования, тесты, ресурсы тестов 
и бизнес-компоненты. Базовое состояние — состояние библиотеки в 
определенный момент времени. Базовые состояния позволяют 
отслеживать изменения проекта. 

Базовые состояния можно сравнивать на всех этапах процесса управления 
жизненным циклом приложения. Например, можно сравнить два базовых 
состояния библиотеки для просмотра изменений, которые были внесены в 
библиотеку. Кроме того, можно сравнивать базовое состояние с текущими 
объектами библиотеки. 

В этом уроке вы создадите библиотеку тестов и требований. Затем вы 
сравните два базовых состояния для анализа изменений библиотеки.

Quality Center Starter Edition: Данный урок невозможно выполнить с 
помощью Quality Center Starter Edition.

Во время этого урока вы узнаете следующее.

 ➤  Создание библиотек на стр. 158

 ➤  Создание базовых состояний на стр. 160

 ➤  Сравнение базовых состояний на стр. 163
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Создание библиотек
В этом упражнении вы добавите библиотеку тестов и требований в 
Quality Center. Для выполнения этого упражнения необходимо войти в 
систему под именем alex_qc.

Чтобы создать библиотеку:

 1 Убедитесь, что вы вошли в проект QualityCenter_Demo  под именем 
alex_qc.

Откройте окно входа в HP Quality Center. В поле Login Name введите 
alex_qc. Пропустите поле Password. 

Дополнительные сведения см. в разделе “Перед началом работы с 
Quality Center" на стр. 19.

 2 Откройте модуль Libraries .

Нажмите кнопку Management на боковой панели и откройте вкладку 
Libraries.

 3 Создайте папку библиотеки.

В дереве библиотек выберите корневой каталог Libraries. Нажмите кнопку 
New Folder. Откроется диалоговое окно New Library Folder.

В поле Library Folder Name введите Folder1.

Нажмите кнопку OK. Папка Folder1 будет добавлена в дерево библиотек.

В поле Description на правой панели введите следующее описание папки 
библиотеки: This folder contains a library of tests and requirements.
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 4 Добавьте библиотеку в папку.

Нажмите кнопку Create Library. Откроется диалоговое окно Create Library. 

В поле Name введите Library1.

В разделе Select Entities в поле Requirement Root Folder  нажмите кнопку 
обзора. Включите в библиотеку папку Mercury Tours Application. Нажмите 
кнопку OK. 

В поле Test Root Folder  нажмите кнопку обзора. В поле Subject выберите 
папку Mercury Tours Site и включите ее в библиотеку.  Нажмите кнопку OK. 

В поле Description введите This library includes tests and requirements.

Нажмите кнопку OK. Новая библиотека будет добавлена в дерево 
библиотек. 
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Создание базовых состояний
Базовое состояние — состояние библиотеки в определенный момент 
времени. Базовые состояния можно использовать для отметки любых 
важных этапов в процессе управления жизненным циклом приложения. 
Базовое состояние включает все объекты, определенные в библиотеке, в 
том числе требования, тесты и ресурсы тестов. Базовые состояния также 
включают отношения между объектами библиотеки, например, 
прослеживаемость и покрытие. Базовые состояния позволяют отслеживать 
изменения проекта.

В следующем упражнении вы создадите начальное базовое состояние, 
которое затем будет сравниваться с другим базовым состоянием для 
оценки воздействия изменений.

Чтобы создать базовое состояние, выполните следующие действия.

 1 Убедитесь, что открыт Libraries модуль.

Если это не так, нажмите кнопку Management на боковой панели и 
откройте вкладку Libraries.

 2 Добавьте базовое состояние к библиотеке

В дереве библиотек выберите библиотеку Library1.

Нажмите кнопку Create Baseline. Запустится процесс проверки.

Quality Center проверит наличие в библиотеке всех связанных объектов 
для каждого объекта в библиотеке, у которого есть связанные объекты.  
Например, для каждого теста, имеющего покрытие требований тестами, 
Quality Center проверит наличие связанного требования в библиотеке.
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Если связанные объекты отсутствует в библиотеке, Quality Center создаст 
их список и откроет диалоговое окно Broken Links Verification. 

Нажмите Continue. Откроется диалоговое окно New Baseline.

В поле Baseline Name введите Baseline1. Нажмите кнопку OK. 
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Базовое состояние будет добавлено в дерево библиотек, и начнется 
процесс его создания.

Создание базового состояния осуществляется в фоновом режиме и может 
занять некоторое время. Вы можете продолжать работу в Quality Center во 
время создания базового состояния.

Во вкладке Details в поле Description введите Baseline of tests and 
requirements. 

 3 Просмотрите журнал внесенных изменений базового состояния.

Во вкладке Details нажмите кнопку View Log. Откроется диалоговое окно 
Log: Create Baseline с информацией о ходе выполнения процесса. Нажмите 
кнопку Close, чтобы закрыть диалоговое окно.

Кнопка View Log будет скрыта.
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Сравнение базовых состояний
Можно сравнивать два базовых состояния в библиотеке. Например, можно 
сравнивать базовые состояния на разных стадиях разработки, чтобы 
оценить влияние изменений требований в проекте. Затем можно будет 
обновить соответствующие тесты.

Кроме того, можно сравнивать базовое состояние с текущими объектами 
библиотеки. Предположим, что базовое состояние создано в начале нового 
релиза. Со временем требования в библиотеке меняются. Чтобы 
определить, соответствует ли разработка продукта планам, можно 
сравнить требования исходного базового состояния с текущими 
требованиями в библиотеке.

В следующем упражнении вы добавите в требование покрытие тестами, а 
затем создадите новое базовое состояние. После этого вы сравните два 
базовых состояния для оценки влияния изменений.

Чтобы сравнить базовые состояния:

 1 Измените требование.

Нажмите кнопку Requirements на боковой панели и откройте модуль 
Requirements.

В дереве требований под Mercury Tours Application разверните 
требование Application Usability. Выберите Keyboard Support. 

Перейдите на вкладку Test Coverage. На вкладке Test Coverage будет 
показано покрытие для этого требования.

Если вкладка Test Plan Tree не открыта с правой стороны, нажмите кнопку 
Select Tests.

Во вкладке Test Plan Tree раскройте папки объектов Mercury Tours Site  и 
HTML Pages.

Дважды щелкните тест HTML Page Source. Тест будет добавлен в таблицу 
покрытия. 

 2 Создайте новое базовое состояние.

Повторите шаги 1 и 2, приведенные на странице 160. В качестве имени 
нового базового состояния укажите Baseline2.
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 3 Выберите базовое состояние для сравнения.

В дереве библиотек выберите Baseline1. Нажмите кнопку Compare To  и 
выберите Select Baseline для сравнения базового состояния с другим 
базовым состоянием. Откроется диалоговое окно Select Baseline. 

Нажмите кнопку обзора и в списке выберите Baseline2. Нажмите кнопку 
OK. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Baseline. 
Откроется диалоговое окно Compare Baselines Tool.

Базовые состояния будут показаны в отдельных панелях, при этом более 
позднее базовое состояние отображается справа. В каждой панели 
элементы библиотеки отображаются в виде иерархической структуры, 
заданной для конкретного модуля. 
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 4 Посмотрите изменения требований между базовыми состояниями.

Нажмите кнопку Go to Next Change в правой панели для просмотра 
изменения. 

Различия между двумя базовыми состояниями отображаются в столбце 
Changes. Изображение указывает на различия в требовании Keyboard 
Support в базовых состояниях.

Для сравнения измененного требования в базовых состояниях выберите 
Keyboard Support и нажмите кнопку Compare Entities на панели 
инструментов. Откроется диалоговое окно Compare Entities. 
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Нажмите кнопку Test Coverage  на боковой панели.

В представлении Test Coverage приводятся подробные сведения об 
объекте в каждом базовом состоянии. Нажмите кнопку Close.
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 5 Посмотрите изменения тестов между базовыми состояниями.

В диалоговом окне Compare Baselines Tool нажмите кнопку Tests  на 
боковой панели.

Нажмите кнопку Go to Next Change в правой панели для просмотра 
изменения. 

Окно указывает на различия в тесте HTML Page Source между базовыми 
состояниями.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Compare Baselines 
Tool.
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10
Настройка проектов

В предыдущих уроках вы узнали, как использовать Quality Center для 
управления всеми этапами процесса управления жизненным циклом 
приложения, включая определение релизов и циклов, формулирование 
требований, планирование тестирования, выполнение тестов и 
отслеживание дефектов.

На этом уроке вы научитесь настраивать проект Quality Center в 
соответствии с требованиями  группы.  Доступ к проекту можно 
контролировать, настраивая пользователей с правами доступа к нему и 
задавая типы задач, которые может выполнять каждый пользователь. При 
добавлении в группу новых участников необходимо назначить проекты, с 
которыми они будут работать, и определить задачи, которые они смогут 
выполнять. 

Вы также можете настраивать свой проект Quality Center, изменяя 
системные поля или добавляя пользовательские поля. System fields 
(системные поля) — это поля Quality Center по умолчанию. Добавлять или 
удалять системные поля нельзя, их можно только изменять. User fields 
(пользовательские поля) — поля, которые может определить 
пользователь.  Пользовательские поля можно добавлять, изменять и 
удалять. 

Поля могут быть связаны с системными списками и списками, 
определяемыми пользователями. Список содержит значения, которые 
пользователь может ввести в поле. Например, если вы планируете 
запускать тесты на двух разных серверах баз данных, можно добавить в 
проект поле Database. Затем можно создать список, содержащий значения 
Oracle и Microsoft SQL, и связать список с полем Database.
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Во время этого урока вы узнаете следующее.

 ➤  Начало настройки проекта на стр. 170

 ➤  Добавление в проект нового пользователя на стр. 173

 ➤  Распределение пользователей по группам на стр. 176

 ➤  Настройка пользовательского поля на стр. 178

 ➤  Создание списка проекта на стр. 181

Начало настройки проекта
Проекты Quality Center настраиваются с помощью окна Project 
Customization. В этом упражнении вы откроете окно Project Customization с 
правами администратора проекта.

Как начать настройку проекта

 1 Откройте окно входа в HP Quality Center.

Убедитесь, что открылось окно входа в HP Quality Center. Дополнительные 
сведения см. в разделе “Перед началом работы с Quality Center" на стр. 19.

 2 Введите имя пользователя с правами администратора и пройдите 
аутентификацию.

В поле Login Name введите alex_qc.

Пропустите поле Password. Этому пользователю не присвоен пароль.

Нажмите кнопку Authenticate. Quality Center проверит имя пользователя и 
пароль и определит, к каким доменам и проектам вы имеете право доступа. 

 3 Войдите в проект.

В списке Domain выберите Default.

В списке Project выберите QualityCenter_Demo.

Нажмите кнопку Login.

Откроется главное окно Quality Center и отобразится модуль, в котором вы 
работали в прошлый раз.
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 4 Откройте окно Project Customization.

Выберите Tools > Customize в левом верхнем углу окна Quality Center. 
Откроется окно Project Customization.

По умолчанию в окне Project Customization содержатся следующие ссылки:

Элемент Описание

User Properties Позволяет изменять свойства пользователя. 
Например, можно изменить свой адрес электронной 
почты. Также можно изменить свой пароль.

Project Users Позволяет добавлять и удалять пользователей в 
проекте Quality Center. Можно также назначать 
пользователей в группы пользователей для 
ограничения их прав доступа.

Groups Позволяет назначать привилегии группам 
пользователей, задавая для них конкретные 
параметры прав доступа.
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Module Access Позволяет контролировать модули, к которым имеют 
доступ группы пользователей. Повышения 
эффективности лицензий Quality Center можно 
добиться, запретив пользователям доступ к модулям, 
в которых они не нуждаются.

Project Entities Позволяют изменять режим работы системных полей 
Quality Center или задавать уникальные 
пользовательские поля для проекта. Например, 
выполняется тестирование нескольких сборок 
приложения, в диалоговое окно New Defect можно 
добавить пользовательское поле Detected in Build. 
Затем можно связать его со списком, в котором 
содержатся значения для этого поля.

Requirement Types Позволяют настраивать определения типов 
требований.

Quality Center Starter Edition: Данный элемент в 
Quality Center Starter Edition отсутствует.

Risk-Based Quality 
Management

Позволяет изменять параметры управления 
качеством на основе рисков.

Quality Center Starter Edition: Данный элемент в 
Quality Center Starter Edition отсутствует.

Project Lists Позволяют добавлять в проект пользовательские 
списки. В список входят значения, которые 
пользователь может вводить в системные или 
пользовательские поля. Например, для поля Detected 
in Build можно создать список, содержащий значения 
Build1, Build2 и Build3.

Automail Позволяет настроить автоматическую рассылку 
сообщений электронной почты, уведомляющих 
пользователей о каждом изменении, внесенном в 
указанные дефекты.

Элемент Описание
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Добавление в проект нового пользователя
Доступ к проекту Quality Center можно контролировать, настраивая 
пользователей с правам входа в этот проект и задавая типы задач, которые 
может выполнять каждый пользователь.

Для каждого проекта выбираются пользователи из списка пользователей 
сайта Quality Center. Этот список создается в модуле Site Administration.

В окне Project Customization в проект добавляются пользователи и 
вносятся в группы пользователей. Каждая группа пользователей имеет 
право доступа к определенным задачам Quality Center. 

В этом упражнении вы добавите нового пользователя в проект 
QualityCenter_Demo.

Чтобы добавить нового пользователя в проект:

 1 Убедитесь, что вы вошли в Quality Center с правами администратора.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе “Начало настройки проекта" на стр. 170.

Alert Rules Позволяют активировать правила оповещений для 
проекта. Настраивает Quality Center на создание 
оповещений и отправку сообщений электронной 
почты об изменениях в проекте.

Workflow Позволяет создавать скрипты для часто 
используемых настроек полей в диалоговых окнах 
модуля Defects. Кроме того, можно создать скрипты 
для настройки диалоговых окон любого модуля и 
контролировать действия, выполняемые 
пользователем.

Элемент Описание



Урок 10 • Настройка проектов

174

 2 Откройте страницу Project Users.

В окне Project Customization щелкните ссылку Project Users. Откроется 
страница Project Users, на которой отобразится список пользователей, 
назначенных проекту.

 3 Добавьте нового пользователя.

Нажмите кнопку Add User. Откроется диалоговое окно Add User to Project.
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В это диалоговое окно можно добавлять существующего пользователя из 
списка пользователей сайта. Для этого нужно ввести имя пользователя или 
выбрать его из списка пользователей сайта. Также можно создать нового 
пользователя и добавить его в проект. 

Для добавления существующего пользователя убедитесь, что выбран 
переключатель Add user by user name. В поле Add user by user name 
введите tom_qc и нажмите OK.

Новый пользователь будет добавлен в список Project Users, а свойства 
пользователя появятся в области Personal Settings. Личные параметры 
пользователя задаются в Site Administration.



Урок 10 • Настройка проектов

176

Распределение пользователей по группам
Чтобы пользователи могли выполнять свои задачи, а также в целях защиты 
от несанкционированного доступа Quality Center позволяет распределять 
пользователей по группам. Каждая группа имеет право доступа к 
определенным задачам Quality Center. Можно использовать 
предварительно заданные группы пользователей с правами по умолчанию 
или настроить собственные группы с уникальными наборами прав. 

В этом упражнении вы добавите нового пользователя tom_qc в группу 
пользователей QATester.
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Для добавления пользователя в группу:

 1 Убедитесь, что отображается страница Project Users.

Если окно Project Users еще не открыто, нажмите ссылку Project Users в 
окне Project Customization.

 2 Выберите tom_qc из списка Project Users.

В списке Project Users выберите tom_qc.  Отобразятся свойства 
пользователя. По умолчанию новый пользователь добавляется в группу 
Viewer.

 3 Введите tom_qc в группу QATester.

Под пунктом Not Member Of выберите пункт QATester и нажмите стрелку 
влево, чтобы переместить его в область Member Of.
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 4 Удалите tom_qc из группы Viewer.

Под Member Of выберите пункт Viewer и нажмите  стрелку «Вправо, чтобы 
переместить его в область Not Member Of.

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Users. Нажмите кнопку OK.

Настройка пользовательского поля
Вы можете создавать уникальные пользовательские поля или изменять 
режим работы системных полей Quality Center.

Поля сохраняются в объектах проекта Quality Center. Например, объект 
Defect содержит данные, введенные в модуле Defects.

В следующем упражнении вы добавите пользовательское поле Database в 
объект Defect. Это поле указывает на базу данных, используемую при 
тестировании приложения.

Для добавления пользовательского поля:

 1 Убедитесь, что отображается окно Project Customization.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе “Начало настройки проекта" на стр. 170.
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 2 Откройте страницу Project Entities.

В окне Project Customization щелкните ссылку Project Entities. Откроется 
страница Project Entities.
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 3 Добавьте новое пользовательское поле в объект Defect .

Под Project Entities разверните Defect. 

Выделите папку User Fields и нажмите кнопку New Field. В папку User 
Fields будет вложено новое поле.

Надпись BG_USER_XX указывает на пользовательское поле под объектом 
Defect.

 4 Измените имя поля по умолчанию.

В поле Field Label вместо имени по умолчанию введите имя Database. 

Нажмите кнопку Save.

Нажмите кнопку OK.
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Создание списка проекта
Поля можно связывать с системными списками и списками, 
определяемыми пользователями. Список содержит значения, которые 
пользователь может ввести в поле. 

В предыдущем упражнении вы добавили поле Database. В ходе 
следующего упражнения вы создадите список и назначите его полю 
Database. Затем вы откроете диалоговое окно New Defect для просмотра 
нового поля.

Чтобы создать список проекта:

 1 Убедитесь, что отображается окно Project Customization.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе “Начало настройки проекта" на стр. 170.

 2 Откройте страницу Project Lists.

В окне Project Customization щелкните ссылку Project Lists. Откроется 
страница Project Lists.

 3 Создайте новый список.

Нажмите New List. Откроется диалоговое окно New List.
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В поле List Name введите DB. Нажмите кнопку OK, чтобы закрыть 
диалоговое окно New List.

 4 Добавьте элемент в список.

Нажмите New Item. Откроется диалоговое окно New Item. Введите Oracle и 
нажмите кнопку OK.

Повторите ту же самую процедуру и добавьте MS SQL в список DB.

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Lists. Нажмите кнопку OK.

 5 Назначьте список полю Database.

В окне Project Customization щелкните ссылку Project Entities. Откроется 
страница Project Entities.

Под Project Entities разверните Defect.

Раскройте папку User Fields и выберите Database.
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Под Field Settings в списке Field Type выберите Lookup List для установки 
типа поля «Раскрывающийся список» Раздел Lookup List отображается 
под разделом Field Settings.

Под Lookup List выберите DB. 

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Entities. Нажмите кнопку OK.
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 6 Просмотрите новое поле пользователя в диалоговом окне New Defect.

Для выхода из окна Project Customization и возврата в проект Quality Center 
нажмите кнопку Return в правом верхнем углу окна.

В модуле Defects нажмите кнопку New Defect. Откроется диалоговое окно 
New Defect. 

Поле Database отображается в диалоговом окне New Defect. 

Нажмите стрелку «Вниз» и посмотрите заданные типы баз данных. 
Нажмите кнопку Close.

Новое 
пользовательское 
поле
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Заключение

Quality Center обеспечивает организацию всех этапов жизненного цикла 
приложения, включая определение релизов и требований, разработку 
плана тестирования, выполнение тестов и отслеживание дефектов, а также 
управление ими. На каждом этапе можно анализировать данные с 
помощью подробных отчетов и диаграмм.
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Этап Описание

Определение 
релизов

Разработайте план релиза и определите циклы для релизов.

Чтобы разработать план релиза:
1  Определите, как разбить релизы приложения на 

компоненты.
2  Для каждого релиза определите способ разбивки на циклы.
3  Проведите анализ хода выполнения и качества релизов и 

циклов.

Определение 
требований

Проанализируйте приложение и определите требования.

Чтобы определить требования:
1  Изучите документацию по разрабатываемому приложению, 

чтобы определить рамки, цели, задачи и стратегии.
2  Создайте дерево требований для определения общих 

требований. После разработки тесты можно использовать 
для покрытия требований. Таким образом, вы сможете 
учитывать потребности на всех этапах процесса 
управления жизненным циклом приложения.

3  Для каждой группы в дереве требований создайте перечень 
подробных требований. Опишите требования, задайте 
уровень приоритета для них, назначьте релизу и циклу и 
при необходимости добавьте вложение .

4  Создайте отчеты и диаграммы, позволяющие облегчить 
анализ требований. Проверьте требования, чтобы 
убедиться в их соответствии целям и задачам.

5  Создайте базовое состояние требований. Базовое 
состояние можно использовать в качестве соглашения, 
которое должны подписать все заинтересованные лица.  
Это базовое состояние будет использоваться в качестве 
точки отсчета, с которой можно сравнивать изменения. 
Базовое состояние требований может проверяться в ходе 
всего проекта для постоянного обеспечения его 
соблюдения.
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Планирование 
тестов

На основе требований разработайте план тестирования .

Чтобы создать план тестирования:
1  Изучите приложение, системную среду и ресурсы 

тестирования, чтобы определить цели тестирования.
2  Разбейте приложение на тестируемые модули или 

функциональные блоки. Создайте дерево плана 
тестирования, чтобы иерархически разбить приложение на 
тестируемые модули или объекты.

3  Определите типы тестов для каждого модуля. Добавьте 
базовое определение каждого теста в дерево плана 
тестирования.

4  Свяжите каждый тест с соответствующим требованием.
5  Разработайте ручные тесты, добавив шаги к тестам дерева 

плана тестирования. Шаги теста содержат описание 
конкретных действий по тестированию и ожидаемый 
результат каждого теста. Решите, какие тесты следует 
автоматизировать. Затем можно связать тесты с 
дефектами.

6  Создайте скрипты для тестов, которые нужно 
автоматизировать. Автоматизация тестов может 
осуществляться с помощью средств тестирования HP, 
пользовательских средств тестирования или средств 
тестирования сторонних производителей.

7  Создайте отчеты и диаграммы, чтобы облегчить анализ 
данных плана тестирования. Проверьте тесты, чтобы 
убедиться в их соответствии целям тестирования.

8  Создайте базовое состояние тестов. Базовое состояние 
теста — это состояние плана тестирования в 
определенный момент времени. Базовое состояние можно 
использовать для того, чтобы отметить важный этап 
жизненного цикла приложения. Это базовое состояние 
будет использоваться в качестве точки отсчета, с которой 
можно сравнивать изменения.

Этап Описание
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Проведение 
тестирования

Создайте наборы тестов и выполните тесты.

Чтобы создать наборы тестов и выполнить тесты:
1  Определите папки наборов тестов и наборы тестов, 

которые соответствуют различным целям тестирования в 
вашем проекте. Каждую папку наборов тестов назначьте 
циклу. Решите, какие наборы тестов включать в 
соответствующие папки с наборами тестов, и какие тесты 
включать в каждый набор.

2  Составьте расписание запуска тестов и поставьте задачи 
перед тестировщиками приложения. 

3  Вручную или автоматически выполните тесты из наборов 
тестов.

4  Просмотрите результаты выполнения тестов для 
выявления дефектов в приложении. Создайте отчеты и 
диаграммы, облегчающие анализ этих результатов.

Отслеживание 
дефектов

Зарегистрируйте обнаруженные дефекты в проекте и 
отследите процесс их устранения.

Для регистрации и отслеживания дефектов:
1  Зарегистрируйте новые дефекты, обнаруженные в 

приложении. 
2  Можно связывать дефекты с другими объектами, такими 

как требования, тесты и другие дефекты.
3  Проанализируйте новые дефекты и определите дефекты, 

подлежащие устранению.
4  Устраните дефекты.
5  Выполните тестирование новой сборки приложения. 

Повторяйте этот процесс до устранения дефектов.
6  Создайте отчеты и диаграммы, которые упрощают анализ 

устранения дефектов и помогают определить срок релиза 
приложения.

Этап Описание
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